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CHAPTER 1 INTRODUCTION TO JASPERREPORTS SERVER

TIBCO JasperReports® Server builds on TIBCO JasperReports® Library as a comprehensive family of Business
Intelligence (BI) products, providing robust static and interactive reporting, report server, and data analysis
capabilities. These capabilities are available as either stand-alone products, or as part of an integrated end-to-end
BI suite utilizing common metadata and provide shared services, such as security, a repository, and scheduling.
The server exposes comprehensive public interfaces enabling seamless integration with other applications and
the capability to easily add custom functionality.

This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you from
using them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

The heart of the TIBCO Jaspersoft® BI Suite is the server, which provides the ability to:

»  Easily create new reports based on views designed in an intuitive, web-based, drag and drop Ad Hoc
Editor.

» Efficiently and securely manage many reports.

* Interact with reports, including sorting, changing formatting, entering parameters, and drilling on data.

*  Schedule reports for distribution through email and storage in the repository.

*  Arrange reports and web content to create appealing, data-rich Jaspersoft Dashboards that quickly convey
business trends.

For users interested in multi-dimensional modeling, we offer Jaspersoft® OLAP, which runs as part of the server.

While the Ad Hoc Editor lets users create simple reports, more complex reports can be created outside of the
server. You can either use Jaspersoft® Studio or manually write JRXML code to create a report that can be run
in the server. We recommend that you use Jaspersoft Studio unless you have a thorough understanding of the
JasperReports file structure. See “Adding Reports Directly to the Repository” on page 157 and the Jaspersoft
Studio User Guide for more information.

You can use the following sources of information to learn about JasperReports Server:

*  Our core documentation describes how to install, administer, and use JasperReports Server and Jaspersoft
Studio. Core documentation is available as PDFs in the doc subdirectory of your JasperReports Server
installation. You can also access PDF and HTML versions of these guides online from the Documentation
section of the Jaspersoft Community website.

*  Our Ultimate Guides document advanced features and configuration. They also include best practice
recommendations and numerous examples. You can access PDF and HTML versions of these guides online
from the Documentation section of the Jaspersoft Community website.

TIBCO Software Inc. 9
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1.1

Our Online Learning Portal lets you learn at your own pace, and covers topics for developers, system
administrators, business users, and data integration users. The Portal is available online from Professional
Services section of our website.

Our free samples, which are installed withJasperReports Library, Jaspersoft Studio, and JasperReports Server,
are documented online. See “Adding Reports Directly to the Repository” on page 157 and Jaspersoft
Studio User Guide for more information.

JasperReports Server is a component of both a community project and commercial offerings. Each integrates the
standard features such as security, scheduling, a web services interface, and much more for running and sharing
reports. Commercial editions provide additional features, including Ad Hoc charts, flash charts, dashboards,
Domains, auditing, and a multi-organization architecture for hosting large BI deployments.

This chapter contains the following sections:

Logging In

The Getting Started Page
The Library Page
Browsing the Repository
Searching the Repository
Using Repository Resources
Sorting the Repository List

Logging In

Launch JasperReports Server by entering http://<hostname>:8080/jasperserver-pro in a web browser,
where <hostname> is the name of the computer that hosts JasperReports Server. The Login page appears.

Help =

TIBC2 Jaspersoft’

Getting Started
(® How-to videos
(& How-to articles

(® Online Learning Portal

® Product documentation

® Find the right edition for you

User 1D:

(® Jaspersoft Quick Start Guide

Password:

What's new in Jaspersoft Version 6?

Dashboards:

A single web environment for creating visualizations,

with a mash-up of Reports, Ad Hoc Views, and web
pages

Show locale & time zone

Need help logging in?
All New JasperMobile Support:

View interactive reports and Dashboards from your

smartphone or tablet with the JasperMobile app

Visualize.js:
Embed Reports and Dashboards directly into highly-
interactive web pages

Figure 1-1 Jaspersoft Login Page

10
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1.1.1

To log in to the server, JavaScript and cookies must be enabled in your browser.

Before logging in, review the information on the login page. There are links to the online help and additional
resources.

To log in to the server:
1. Enter your user ID and password.

If you installed an evaluation server with the sample data, you can log in with the sample user IDs and

passwords. For more information, click Need help logging in?

If the Organization field appears in the Login panel, enter the ID or alias of your organization. If you don’t know
it, contact your administrator. For more information, see “Logging into a Server with Multiple Organizations”
on page 11.

The default administrator login credentials are superuser/superuser and jasperadmin/jasperadmin.

@ For security reasons, administrators should always change the default passwords immediately after installing

JasperReports Server, as described in the JasperReports Server Administrator Guide.

2. Ifyou want to use a different locale and time zone than the server uses, click Show locale & time zone.
The Locale and Time Zone fields appear in the Login panel. Select your locale and time zone from the
drop-down menus.

3. Click Login.

If you entered a valid user ID and password, the server displays the Getting Started page, as shown in
Figure 1-3.

Logging into a Server with Multiple Organizations

If the administrator has configured your server to use the multi-tenancy feature, it supports multiple
organizations. Each organization has its own private area for storing files and resources. The default Login
dialog for a multi-tenant server has an additional field: Organization. The left side of Figure 1-2 shows this
field. Enter the ID or alias of your organization. For example, enter the ID of the default organization:
organization 1.

You don’t have to enter the organization ID each time you log in. The first time you log in, include the

organization ID in your login URL, as shown on the right side of Figure 1-2. Bookmark the URL and use it for
subsequent log ins. The Organization field does not appear in the dialog when you specify it in the URL.

TIBCO Software Inc. 11
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1.2

Login

Crganization:

organization_1

User ID:

Passwaord:

Show locale & time zone

MNeed help logging in?

Figure 1-2 Login Methods for Multiple Organizations

Login

lser ID:

Passwaord:

Show locale & time zone

MNeed help logging in?

The superuser account does not specify an organization because it is the system-wide administrator. If the
Organization field appears in the Login dialog when you log in as superuser, leave it blank. If you try to log
in as superuser with an orgID in the URL, the server returns an error.

The Getting Started Page

From the Getting Started page, you can quickly access the most frequently used features of the server.

12
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Home

» Recently Viewed Items

You have no recently viewed items

» Popular Resources

® How-to videos
& How-to articles

® Online Learning Portal

(1

Data Sources
Define connection to a
database or other data
source. View tutorial

Create View list

Ad Hoc Views

Visualize your data for
analysis and report
creation. View tutorial

{0

Domains

Add structure to a data
source for use in an Ad
Hoc view. View tutorial

Create View list

Reports

Create and format
interactive reports from
existing Ad Hoc views.

Create View list View tutoria]

Create View list

Admin

Configure your server
w instance and manage user
settings.

View options

Combine related reports
into custom dashboard
layouts. View tutorial

<
@ Dashboards 3

Create View list

Figure 1-3 Getting Started Page

1.2.1 Core Workflows

The Getting Started page for standard users has multiple blocks that link to the core workflows of JasperReports

Server, that may include some or all of the following options:

+ Data Sources — Select or define a connection to a database or other data source.

* Domains- Add structure to your data source for use in an Ad Hoc view.

* Ad Hoc Views — Select or create the visualization for your data.

* Reports — Create an interactive report from an Ad Hoc view, or select an existing report.

+ Dashboards — Combine related reports into one layout, or select from existing layouts.

* Admin - Configure your server and manage user settings. This block is visible only to users with
administrator privileges.

Each workflow block on the Getting Started page may contain links to video tutorials, pages or wizards to
create related elements, and filtered repository lists containing relevant items. Click these links, rather than the
blocks themselves, to access these resources. Users with administrator access may have more of these options
available to them.

1.2.2  The Getting Started Column

On the left side of the page, there are two lists to help you locate and access relevant information and assets.

* Popular Resources — Includes links to educational and support resources.
* Recently Viewed Items — Includes links to up to 10 recently viewed repository items, such as reports, Ad
Hoc views, dashboards, and the like.

TIBCO Software Inc. 13
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1.2.3 Menu Items

The menu items along the top of the Getting Started page are available from every page on JasperReports

Server. kit and the Library, View, Manage, and Create menus offer the options described in the table below.

Menu Description

[ |
Returns to the Getting Started page.

Library Displays a pared-down repository page that contains the Ad Hoc views, reports, and
dashboards the currently logged-in user has rights to

View + Search Results — Displays the repository of resources filtered by criteria selected in the
Filters panel.

* Repository — Displays the repository of files and folders containing resources, such as
reports, report output, data sources, and images.

* Schedules - Lists the reports that you have scheduled.

+ Messages — Lists system messages, such as an error in a scheduled report.

+ Ul Samples — (administrators only) Presents galleries of Ul components that you redesign
using Themes.

Manage + Organizations — Opens the Manage Organizations page.

* Users — Opens the Manage Users page.

* Roles — Opens the Manage Roles page.

« Server Settings — Opens the Server Settings | Log Settings page.

Create + AdHoc View — Launches the Ad Hoc Editor for designing views interactively.

* Report — Launches the Create Report dialog for creating a report based on an Ad Hoc
view and a report template.

+ Dashboard — Launches the Dashboard Designer for laying out multiple reports with input
controls, labels, and images.

* Domain - Launches the Domain Designer for setting up a Domain.

+ Data Source — Launches the New Data Source page for specifying the attributes of the
new data source.

If you log in as an administrator, the Home page has additional options and menu items for managing users,
roles, organizations, and settings, such as repository folder names. Administrator functions are documented in
the JasperReports Server Administrator Guide. The links to the Online Help, Log Out, and a search field
appear on all JasperReports Server pages. For more information about searching, see “Filtering Search Results”
on page 18.

1.2.4  JasperReports Server Keyboard Shortcuts

JasperReports Server provides keyboard shortcuts to help you navigate its web UI without the use of a mouse or
other pointing device. These shortcuts are available on the Login page, the Home page, the Library Page, the
Repository page, the Search Results page, and the interactive report viewer, allowing you to log in, move
between major navigational elements of these page, select and open reports, and navigate tabular reports.

14 TIBCO Software Inc.
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1.3

Shortcuts include:

Key Action

Left Arrow Navigate left one column, cell, or item.

Right Arrow Navigate right one column, cell, or item.

Up Arrow Navigate up one row, cell, or item.

Down Arrow Navigate down one row, cell, or item.

Enter Select an item or navigate into an inner control.

Escape Cancel an action or navigate out to an outer control.

Tab Navigate to the next major region or form field.
Focus moves from left to right.

Note that, on some pages, the Shift key can also be used in conjunction with the arrow keys or Tab:

*  When used with the arrow keys, Shift multi-selects items, such as reports listed in the Library page.
*  When used with Tab, Shift changes the direction that focus moves from left to right to right to left.

In addition, the web UI has improved compatibility with screen readers, which assist visually impaired users in
using computers. The implementation follows the WAI-ARIA (Web Accessibility Initiative Accessible Rich
Internet Applications Suite) technical specification, and has been certified for certain versions of JAWS (Job
Access With Speech) with certain browsers:

* Internet Explorer 8 with JAWS 14

* Internet Explorer 11 with JAWS 16

To further increase JasperReports Server's accessibility, we recommend that you enable the Easy Access theme,
which increases color contrast and highlighting in the web UL It can improve the user experience of those with
visual impairment. For more information on themes, see the JasperReports Server Administrator Guide.

The Library Page

The Library page offers a more focused view of the repository objects. It contains only the Ad Hoc views,
reports, and Dashboards that the currently logged-in user has rights to view and work with.

Click Library to view your Library list.

TIBCO Software Inc. 15
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1.3.1

1.4

Library Sort By: Name | Modified Date

L Name Description Type Created Date  Modified Date
01. Geographic Results by Segment Sample HTMLS multi-axis column chart from Domain showing S.. Ad Hoc View April 28 10/21/2014
01. Geographic Results by Segment Re... Sample HTMLS multi-axis column chart from Domain showing .. Report April 28 9/24/2014
02. Sales Mix by Demographic Sample HTMLS Spider Line chart from OLAP source Ad Hoc View April 28 11/24/2014
02. Sales Mix by Demographic Report Sample HTMLS Spider Line chart from OLAP source. Created fr... Report April 28 9/24/2014
03. Store Segment Performance Sample OLAP chart with HTML5 Grouped Bar chart and Filter Ad Hoc View April 28 10/21/2014
03. Store Segment Performance Report Sample OLAP chart with HTMLS Grouped Bar chart and Filter. C... Report April 28 9/24/2014
04. Product Results by Store Type Sample Filtered Table Report Showing Multiple Measures Ad Hoc View April 28 5/15/2014
04. Product Results by Store Type Report Sample Filtered Table Report Showing Multiple Measures. Creat.. Report April 28 5/15/2014
05. Accounts Report Basic interactive Table Component report with Bookmarks Panel Report April 28 4/17/2014
05g. Accounts Report Basic interactive Table Component report with alternate color s... Report April 28 10/3/2013
05. Unit Sales Trend Sample HTMLS Time Series chart from Topic for Unit Sales dat.. Ad Hoc View April 28 4/25/2014
06g. Profit Detail Report Sample report containing containing interactive HTMLS Chart a.. Report April 28 5/13/2014
06. Profit Detail Report Sample report containing containing interactive HTMLS Chart a.. Report April 28 5/13/2014

Figure 1-4 Library Panel

From the Library page, you can:

*  Run and schedule reports

*  Open Ad Hoc views and generate reports from them
*  Run and edit dashboards

*  Run OLAP views

All of these functions are available by right-clicking the item you want to work with and selecting an action
from the context menu.

Created vs. Modified Dates
The Library table has two columns that refer to when the repository items were created and last modified.

Generally, the created date will be earlier than the modified date. In some situations, however, the created date

may be after the modified date. This can happen for one of two reasons:

*  When an existing report (A) is modified, then subsequently copied into a new report (B). In the Library list,
report B’s created date is the day it was created, but its modified date reflects the last time report A was
changed.

*  An existing report is exported from one system and imported into another. In the Library list, the reports
created date is the date it was imported into the new system, and the modified date is the date it was last
modified in the original system.

Browsing the Repository

The repository is the server’s internal storage for reports, analysis views, and related files. The repository is
organized as a structure of folders containing resources, much like a file system. However, unlike a file system,
the repository is stored as a private database that only JasperReports Server can access directly.

To browse the repository, select View > Repository. From the repository page, you access the reports, themes,
and other files stored on the server. You can browse the repository contents that you have permission to view

16
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1.5

1.5.1

by expanding icons in Folders. Click a folder name to view its contents. In Figure 1-5, you'll see the

Repository page.

0 Folders

E-|_‘ Organization

E-l_AAd Hoc Components
Ad Hoc Reports

Analysis Components
Content Files
Dashboards
Data Sources
Domains
Images
Organizations
Performance
Reports
SuperMart Demo
Temp
Templates
Themes

Repository

Name

All Accounts Report
Cascading multi select topic
Customers Report

demo for adhoc
Employees

foodmart data for crosstab
i18n columns

MDX example
Parameterized Report
Simple Domain Topic
SuperMart Products

SuperMart Stores

Figure 1-5 Repository Folders Panel

Searching the Repository

Description

All Accounts Report

Shows cascading input controls. Multi-select and

Parameterized Report with no default values for ...

Topic containing shipping costs for orders

Employee List topic based on Employee List repo..

foodmart data for crosstab

Columns are Internationalizable.<br=Default su...

Example of topic with MDX query
Parameterized Report

Simple example of Domain saved as Topic

Information about all of the products sold by Su..

Simple Topic. Good for trying calculations (sales...

Type

Report
Report
Report
Report
Report
Report
Report
Report

Report

Domain Topic  April 28

Report

Report

Sort By: Name | Modified Date

Created ...  Modified ..
April 28 April 28
April 28 April 28
April 28 April 28
April 28 April 28
April 28 April 28
April 28 April 28
April 28 April 28
April 28 April 28
April 28 April 28
April 28
April 28 April 28
April 28 April 28

You can search the entire repository, subject to permissions, or narrow the search using filters. Filters restrict a
search by name, who changed the resource, type of resource, date of the resource, and schedule.

Searching the Entire Repository

To search the repository, select View > Search Results. The search results page appears. Instead of only
viewing resources by folder, use intuitive search criteria, such as who modified the resource and when, to find

pinpoint resources.

On the search results page, use either the Filters panel or Search field to find resources. The search results page
displays results of searches and filters.

TIBCO Software Inc.
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& Folders Repository Sort By: Name | Modified Date
{5l root
Sl Organizations o .
(5 TEn= 52 Name Description Type Creatsd .. Modified ...
I Folder Template
5 All A s g Report Apr Apr
Sl Organization All Accounts Report Il Accounts Report epor pril 28 pril 28
Sl Ad Hoc Compon Cascading multi select topic Shows cascading input controls. Multi-select an Report April 28 April 28
Ad Hoc Repo Customers Report Parameterized Report with no default values fo Report April 28 April 28
TR demo for adhoc Topic containing shipping costs for orders Report April 28 April 28
| Analysis Compo. . . . § §
- " Employees Employee List topic based on Employes List re... Report April 28 April 28
| Content Files
= foodmart data for crosstab foodmart data for crosstab Report April 28 April 28
| Dashboards
| o) ST i18n columns Columns are Internationalizable.<br>Default s... Report April 28 April 28
| Domains MDX example Example of topic with MDX query Report April 28 April 28
I Images Parameterized Report Parameterized Report Report April 28 April 28
AR genss bons Simple Domain Topic Simple example of Domain saved as Topic Domain Topic  April 28 April 28
I Performance
— SuperMart Products Information about all of the products sold by S Report April 28 April 28
I Reports
= SuperMart Stores Simple Topic. Good for trying calculations (sale Report April 28 April 28

| SuperMart Demo
] Temp
I Templates

| Themes

Figure 1-6 Search Results Page

To search all resources in the repository:
1. Select one of these filters: All available, Modified by me, or Viewed by me.

2. Click the icon in the search field to clear the search term if there is one.
Select All types, as shown in Figure 1-6.

4. Click p

The search results appear listing files that your user account has permission to view. Click a resource in the
list to view it or right-click a resource to see what functions are available from the context menu.

The server remembers your settings on the Search Results page, so the most commonly needed resources remain
visible when you return to the page.

1.5.2  Filtering Search Results

If you enter a search term and click L at the top of any server page, the server doesn’t use filters. The search
uses these default settings:

* Include subfolders

»  Start at the top-most folder visible to the user

*  Search for reports, report outputs, OLAP views, or other resources

*  Sort alphabetically by name

If you click View > Search Results and click P on the search results page, the server uses the filters you set
in the Filters panel.

In Figure 1-7, you can see the results of a search for the term “account” using the filters All available and All
types.
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Filters
e All available
Modified by me

Viewed by me

All types
® Reports
Report outputs

More choices...

Repository  account Sort By: Name | Modified Date
'account’ Reports
Name Description Type Created .. Modified ...
05. Accounts Report Basic interactive Table Component report with B... Report April 28 4/17/2014
05g. Accounts Report Basic interactive Table Component report with al... Report April 28 10/3/2013
20.1 Account List Sample Report used for basic Visualize.js demo Report April 28 5/16/2014
All Accounts Report All Accounts Report Report April 28 April 28

Figure 1-7 Search Field and Search Results

The search term you enter in the search field isn’t cleared automatically. To clear the search term, click the
icon in the search field.

You refine a search using filters. For example, filters can help you find your most recently viewed reports. You
can set each filter independently. You can set the following types of filters:

* User

*  Resource

*  Access time

*  Scheduled report

The user filter has the following settings:

Filter Setting

Description

All Available (default)

All resources.

Modified by me

Selects only resources that were last modified by the user who'’s logged in.

Viewed by me

Selects only resources that were run and viewed by the user who’s logged in. This
filter not only applies to visualization types, but also to resources that are included in
reports such as images.

The resource type filter has the following settings:

Filter Setting

Description

All types (default)

All resources.

Reports Displays only reports, both JRXML reports and Ad Hoc reports.

Report outputs Displays only the output from reports that were scheduled or run in the background.
Report output can be any of the supported export types, such as HTML and PDF.

Dashboards Displays only dashboards.

TIBCO Software Inc.
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Filter Setting

Description

OLAP views

Displays only analysis views (if you implement Jaspersoft OLAP).

Domains

Displays only Domains.

Data sources

Displays only data sources.

The access time filter has the following settings. All times are relative to the user’s effective time zone:

Filter Setting

Description

Any time (default)

All resources.

Today Resources viewed or modified since the previous midnight.

Yesterday Resources viewed or modified during the previous day ending at midnight.
Past week Resources viewed or modified during the past 7 days, including today.
Past month Resources viewed or modified during the past 30 days, including today.

The scheduled report filter has the following settings:

Filter Setting

Description

Any schedule (default)

All resources.

Scheduled

Only reports that have scheduled jobs.

Scheduled by me

Only reports that have jobs scheduled by the currently logged in user.

Not scheduled

Only reports that don’t have scheduled jobs and all other resource types.

Remember these do's and don'ts when searching for resources:

Using Repository Resources

Do use word fragments.

Do search for the display name or part of the display name of a resource.
Do search for words or fragments in the description of a resource.

Do use multiple words.

Don’t search for folder names.

Don’t enter quotes around terms or symbols between terms.

Don’t worry about using upper- or lower-case letters in search terms.

After finding a resource in the repository, naturally you want to do something with it. Options are:

3

3

Click the name of a report to run and view it.

Right-click the name of a resource to access other operations on the context menu, for example Edit or

Open in Designer. Items appear on the context menu according to your permissions.

20
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*  Click anywhere in the row except the resource name to select a resource. Ctrl-click anywhere in the rows to
select multiple resources. Use the context menu or buttons above the results list: Run, Edit, Open, Copy,
Cut (move), or Delete. If the button is unavailable, the resource doesn’t support the operation or you don’t
have permission for the operation. For example, the Open button is available when you select a dashboard
or an Ad Hoc report if you have permission to write to it.

You might also need permission to access the folder or dependent file, such as an image, of a resource. For
example, to schedule a report, you need to have read/write/delete permission on the folder where server
saves the report output. For more information about permissions, see the JasperReports Server Administrator
Guide.

These two icons may appear in the Repository panel:

. " indicates that the report has saved options for its input controls. Click the " icon to list the saved
options. For more information, see “Running a Report with Input Controls or Filters” on page 65.

. indicates that the report is scheduled to run or is running in the background. Click this icon to view the
list of jobs scheduled for the report. For more information, see “Scheduling Reports” on page 70.

Moving Folders

If you have read permission on folders and resources, you can copy and cut them from one folder and paste them
to another if you have write permission on the destination folder. The server pastes all contents of the folder
into the new location.

You can drag-and-drop the objects instead of using the paste menu item. Move folders one at a time. You can
move other resources in batches.

Relocated objects inherit permissions from the destination folder, losing the permissions in place before
the move. To change permissions on an object, set the permissions explicitly.

To move folders and resources by cutting and pasting:
1. Log into the server as a user who has these permissions:

* Read permission on the folder or resource to move
*  Write permission on the destination folder
For example, log in as joeuser (use the password, joeuser).

2. Click View > Repository.
3. In the Folders panel, right-click Reports > Samples and select Add Folder.
4. In the Add Folder dialog, enter a name, such as Financial Reports, and click Add.

The Financial Reports folder appears as a subfolder of Samples and inherits Joe User’s default permissions
(read-write-delete) on the parent folder.
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Folders

=l Organization

Ad Hoc Components
Additional Samples
Analysis Commponents
Content Files

Dashboards

Ty E B B B ®

Reports

Ho Interactive

+l.l Financial Repaorts

Figure 1-8 New Financial Reports Folder

5. The Financial Reports folder deserves a more prominent location. Move it up one level:
a. In Folders, right-click Financial Reports, and select Cut.
b. Right-click Reports, and select Paste.
The Financial Reports folder now appears in Reports at the same level as Samples.

You can relocate a folder, subject to permissions, anywhere in the repository with one exception: The
server doesn’t support copying and pasting a folder to the same location. If the Paste command is
disabled when you right-click a destination folder, you don’t have write permission on the folder.

1.8 Sorting the Repository List

To change the order of the list of reports and other resources, use the Sort By controls:

*  Click Name to sort alphabetically (A at the top). This is the default sort order.
*  Click Modified Date to sort by the latest modified time and date (most recent at the top).
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This section describes functionality that can be restricted by the software license for JasperReports
Server. If you don’t see some of the options described in this section, your license may prohibit you from
using them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

A Jaspersoft dashboard displays several reports in a single, integrated view. A dashboard can include input
controls for choosing the data displayed in one or more dashlets, and custom dashlets that point to URLs for
other content. By combining different types of related content, you can create appealing, data-rich dashboards
that quickly convey trends.

Profit Average Sale Growth

$646,582 $138 90.9% 7,824

Figure 2-1 Sample dashboard

Dashboards created with JasperReports Server 6.0 and later use the Dashboard Designer, Jaspersoft's web UI for

grouping all of these elements, along with creating new content from existing JasperReports Server data sources.
The majority of the information in this chapter applies to dashboards created with JasperReports Server 6.0 and

later.

If you're working with an earlier version of JasperReports Server, or dashboards created in an earlier version
(regardless of your currently-installed version of JasperReports Server), you'll find information on working with
dashboards at the end of this chapter, in section 2.8, “Viewing Legacy Jaspersoft Dashboards,” on page 47
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This chapter contains the following sections:

*  Overview of the Dashboard Designer

* Viewing a Dashboard

*  Creating a Dashboard

* Editing a Dashboard

* Tips for Designing Dashboards

* Viewing Legacy Jaspersoft Dashboards

2.1 Viewing a Dashboard

You can view a dashboard if you have the proper permissions. The default location for dashboards is the
/Dashboards folder. The following procedure walks you through opening one of JasperReports Server's samples,
the SuperMart dashboard.

To view the SuperMart dashboard:
1. Log in as user demo, using the password demo.

Passwords are case-sensitive. You must use lowercase when you type demo.

The SuperMart dashboard opens in the dashboard viewer. This dashboard includes five reports and an input

control.
1. Supermart Dashboard
i » )
Top Fives " Ssales Trend & Country:
SuperMart Performance I 0k P
Top§
Cumomers
1 MaryFencetengar  S————s S10m
— StoreSales
2 widoncamscn S tom0

—StareCost  price Performance v

3 ida podrgue ———— zam

4 B Hovat s 503
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1 HighRolkr St g5a Weracruz

Demographic Mix " Store Type Metrics & of

<k Fagds alisco
——— sy ngggfvm‘gx N " N &05 J
““““ szm - = Cuerrern
¥ " i 60.25
- FrozenT35H ® oF
"t s § o o
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Figure 2-2 SuperMart Dashboard Example

2. In the Country input control dashlet, click the text entry box.
3. Select USA, then click Closeto change the data displayed.

The four reports with Country data update to display data for USA only. the Top 5 report, which does not
contain Country data, does not change.
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4. When done, click View > Repository to go to the repository page.

Keep these points in mind when viewing a dashboard that has input controls:

* An input control may appear as a text field, a drop-down, a check box, a multi-select list box, or a calendar
icon.

* If one of the dashlets in a dashboard does not refer to an input control, that dashlet does not update when
you change that input control’s value. Only reports that use the input control reflect the change.

* Ifthe Y button appears on the toolbar, then the dashboard was set up to display input controls as a
pop-up window instead of a dashlet. Click the button to view the controls.

If a dashboard does not appear when you click on its name in the repository, it may already be open
in another window or tab of your browser.

2.2 Overview of the Dashboard Designer

The Dashboard Designer is a web-based Ul for embedding reports, Ad Hoc views, and other BI objects into a
single, interactive space. You can compile dashboards that include pre-existing elements, such as reports and
views, and create new charts, tables, and crosstabs from your data sources directly from the designer.

Each element on your dashboard is called a Dashlet. Dashlets have unique names and resource IDs, and
editable properties that vary depending on the Dashlet type.

Your permissions to access the repository may limit the content you can add and the location where you can
save the dashboard.
This section includes:

*  The Dashboard Designer Interface
*  Dashlets and Dashboard Elements
*  Dashboard Properties

*  Dashlet Properties

*  Parameter Mapping

2.2.1 The Dashboard Designer Interface

The following figure shows the basic layout of the Dashboard Designer.
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Figure 2-3 The Dashboard Designer Ul

New Content
Chart
Crosstab
Table

Text

Web Page
Image

Existing Content

01. Geographic Results

01. Geographic Results ...

es Mix by Demog...

03. Store Segment Perf.
03. Store Segment Perf.
04. Product Results by
04, Product Results by ..
05. Accounts Report
05g. Accounts Report
05. Unit Sales Trend

06g. Profit Detail Report

Filters

es Mix by Demog...

New Dashboard

© B.| « »

Start building your dashboard:

Drag an item from the Available Content panel
onto the canvas to create a dashlet.

Use automatic placement or drag the edge of a
dashlet to resize it.

Use the Properties button in the toolbar to set
dashboard-level properties.

Double-click on a dashlet to edit its properties.
Right-click a dashlet to see all available options.

The Dashboard Designer Ul includes the following panels:

Available Content. From here, you can drag content onto the Dashboard Canvas. This panel includes the
following sections:
* New Content, which lists the content elements you can create for your dashboard.

« Existing Content, which lists the Ad Hoc views and reports you can access from the Repository.
*  Filters, which lists all filters associated with any resource added to the dashboard.

Toolbar Buttons. See table below for details.

Icon

Name

Description

Preview

Click to display current dashboard as viewed by the end user.

e

Save/Save As

Hover cursor over icon to open a menu of save options.

Parameter Mapping

Click to open the Parameter Mapping dialog. See Parameter
Mapping for more information.

Undo Click to undo the most recent action.
Lo
- Redo Click to redo the most recent undone action.
O Undo All Click to revert the dashboard to the most recently saved state.
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Icon Name Description
P Dashboard Click to open the Dashboard Properties box. See Dashboard
- Properties Properties for more information.
22 Show/Hide Grid Click to display or hide a grid.
h Show/Hide Filter Click to display or hide a filter pop-up window. This button only
Dashlet Pop-up appears when you enable filter dashlet pop-ups in Dashboard
Properties.

+ Dashboard Canvas. This is where you create and edit your dashboard. It includes the following sections:
« Title Bar, which displays the name of the dashboard (in the figure above, the name is "New
Dashboard").
* Main Creation Area, where you build your dashboard. Drag elements from the Available Content
panel here to get started.

2.2.2 Dashlets and Dashboard Elements
Each element added to your dashboard is called a Dashlet.
To add a Dashlet to your dashboard, simply select a content element and drag it onto the dashboard canvas.

Dashlets can include the following elements, which you can access from the Available Content panel:

* New Content:

* Chart: Allows you to create a chart within the Dashboard Designer.

» Crosstab: Allows you to create a crosstab within the Dashboard Designer.

* Table: Allows you to create a table within the Dashboard Designer.

*  Text: A free-form text entry field. Use free text items to add titles and instructional text to the
dashboard.

« Web Page. Any URL-addressable web content. The dashboard can point to web content.

* Image: An image from the repository or that is accessible by a web address URL. For example, you
might include a dashlet that displays your corporate logo. The logo's image file can either be in your
repository or on the server of your corporate website.

+ Existing Content: Reports and Ad Hoc views accessible to you.

*  Filters: If a report you include on the dashboard is designed to use input controls or filters, you can add
that capability to the dashboard. The server maps input controls to one or more dashlets. Controls can also
be manually mapped to custom URL dashlets.

+ Title Bar: You can enable a title bar in the Dashlet Properties dialog box. The title bar includes the
following elements:

*  The Dashlet name, as entered in the Dashlet properties.

*  Dashlet toolbar, which can contain the following:

Icon Name Description

b ] Maximize Click to open the dashlet as a larger view.
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Icon Name Description

Refresh Click to refresh the dashlet.

For more advanced functionality, you can access dialog boxes that let you edit the overall appearance of your
dashboard, modify the functionality of your dashlets, and create mappings between your dashboard input
controls and your dashlets.

Previewing a Dashboard

You can preview your dashboard to see how it will appear when an end-user views it.
To preview a dashboard:

1. Click G . The dashboard opens in preview mode.

2. To close the preview and return to the Dashboard Designer, click E

Dashboard Properties

You can view and edit the basic appearance of all dashlets on your dashboard, and determine the refresh
settings, through the Dashboard Properties.

To view and edit the Dashboard Properties:

1. On the dashboard toolbar, click % to open the Dashboard Properties window.
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Dashboard Properties

Canvas and Dashlet Settings:

Show filter dashlet as pop-up
#| Show dashlet borders

Dashlet outer margin in pixels: | 5

Dashlet inner padding in pixels: | 5

Fixed canvas size in pixels by

Buttons and Toolbar Settings:

Show Export button

Refresh Settings:

Auto-refresh dashboard contents

Refresh Interval;

m 0K Cancel

Figure 2-4 Dashboard Properties

2. Edit the Canvas and Dashlet Settings, if needed:

+ Show filter dashlet as pop-up: Select when you want the filter dashlet to appear as a pop-up
window instead of a dashlet pinned on the dashboard.

» Show dashlet borders: Select or deselect this to show or hide the thin lines around each dashlet.

+ Dashlet outer margin in pixels: Enter the desired width, in pixels, of the margins between dashlets.

* Dashlet inner padding in pixels: Enter the desired width, in pixels, of the padding inside each
dashlet.

* Fixed canvas size in pixels: Select when you want the dashboard to be displayed at a specific width
and height instead of dynamically resizing based on the browser window. Enter the desired width and
height of the dashboard.

3. Edit the Button and Toolbar Settings, if needed:
*  Show Export Button: Sclect or deselect to show or hide the Export button in the dashboard viewer.
4. Edit the Refresh Settings, if needed:

+ Auto-refresh dashboard contents: Sclect or deselect this to enable or disable automatic refresh for

your content.

* Refresh Interval: Enter the number of minutes or seconds between each content refresh, using the text
entry and drop-down menu.
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Dashlet Properties

You can view and edit basic information and appearance for each dashlet on your dashboard using the Dashlet
properties. For some dashlets, you can also create parameters which you can then map to in Parameter Mapping.
The available properties vary based on the type of dashlet you are working with.

To view and edit the Dashlet properties:
1. Right-click on the dashlet and select Properties to open the Dashlet Properties window. The Hyperlinks
tab is available for Ad Hoc-based charts and charts created inside the dashboard.

Dashlet Properties

Basic Hyperlinks

Dashlet Name:

Sales Trend

Resource ID:
Sales_Trend

Source Data:
Jorganizations,/organization_1/adhoc/topics/CrosstabDemo

Show/Hide Dashlet Elements:
#| Show title bar
Show refresh button

#| Show maximize button

Refresh Settings:
Auto-refresh dashlet contents

Refresh Interval:

m 0K Cancel

Figure 2-5 Dashlet Properties
2. Click Apply to view the changes, OK to accept the changes, and Cancel to discard the changes.

Properties for Dashlets containing charts, crosstabs, tables, reports, and Ad Hoc views include:

* Dashlet Name: Editable field for the displayed dashlet name.

* Resource ID: Non-editable ID taken from the original dashlet name.

* Source Data: Non-editable path of the source data.

* Show/Hide Dashlet Elements: Select or deselect to show or hide the title bar, which includes the dashlet
name, refresh button, and maximize button.

* Scale to Fit: Use the drop-down menu to determine how the element is scaled in the dashlet.

30

TIBCO Software Inc.



Chapter 2 Working with Dashboards

3

Refresh Settings: Sclect or deselect to enable or disable auto-refresh, and use the text entry and drop-
down menu to set the time between each content refresh. This setting overrides refresh properties set at the
dashboard level.

Properties on the Hyperlink tab for Dashlets containing charts include:

The Hyperlinks tab is available for Ad Hoc-based charts and charts created inside the dashboard.

Enable chart hyperlinks: Sclect or deselect to enable a hyperlink for the dashlet

Action: Select link behavior for this dashlet:

* Update dashboard: Select this option to update dashlets linked to this one when a user clicks on a
data point in the chart.

the bubbles in the Store Segment Performance with Hyperlinks chart.

For an example of linked dashlets, open the 2. Performance Summary Dashboard, and click on one of

Open new page: Select this to have the dashlet open a web page or report, dashboard, or an Ad Hoc

view in the repository when a user clicks on the dashlet.

You can link directly to a web page using http: syntax:
http://en.wikipedia.org/wiki/$P{Customer Country}

A repository URL must begin with repo:, for example,
repo:/public/Samples/Ad Hoc Views/05. Unit Sales Trend

To find the correct syntax for a path in the repository, hover over the resource name in the Existing
Content panel in the Dashboard Designer or open the resource's Properties dialog from the
repository.

You can add a parameter to a hyperlink for a web page, dashboard, or report. Parameters are not
available for Ad Hoc views. See 2.4, “Specifying Parameters in Dashlets,” on page 39 for more
information about adding parameters to hyperlinks.
Available parameters: When you add a parameter, use a name in this list to have Parameter Mapping
create the link to the parameter automatically.
Create Links in Parameter Mapping: When you add a parameter, click this button to save and close the
Dashlet Properties window and open Parameter Mapping. See Parameter Mapping for more information.

Properties for Dashlets containing text include:

3

3

Dashlet Name: Editable field or the displayed dashlet name.

Resource ID: Non-editable ID taken from the original dashlet name.

Text: Editable field for the text displayed in the dashlet.

Scale to Fit: Use the drop-down menu to determine how the text is scaled in the dashlet. This overrides
the specified font size.

Font: Use the selection lists and buttons to set the font, font size, font style, alignment, and font color for
the text displayed in the dashlet.

Properties for dashlets containing a Web Page include:

Dashlet Name: Editable field for the displayed dashlet name.
Resource ID: Non-editable ID taken from the original dashlet name.
Web Page Address (URL): Editable field for the URL displayed in the dashlet.
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* Show/Hide Dashlet elements: Select or deselect to show or hide the title bar, which includes the dashlet
name, refresh button, and maximize button.

*  Show scroll bars: Select or deselect to show or hide scroll bars.

* Refresh Settings: Select or deselect to enable or disable auto-refresh, and use the text entry and drop-
down menu to set the time between each content refresh. This setting overrides refresh properties set at the
dashboard level.

Properties for dashlets containing an image include:

* Dashlet Name: Editable field for the displayed dashlet name.

* Resource ID: Non-editable ID taken from the original dashlet name.

*  Web Address/Repository URI: Editable field for the location of the image displayed in the dashlet. This
can include parameters.

To find the correct syntax for a path in the repository, open the resource's Properties dialog from the
repository.

* Show/Hide Dashlet elements: Select or deselect to show or hide the title bar, which includes the dashlet

name, refresh button, and maximize button.
* Scale to Fit: Use the drop-down menu to determine how the image is scaled in the dashlet.

Properties for dashlets containing a filter include:

+ Dashlet Name: Editable field for the displayed dashlet name.

* Resource ID: Non-editable ID taken from the original dashlet name.

* Show/Hide Dashlet buttons: Select or deselect to show or hide the Apply button or Reset button.
* Position of dashlet buttons: Use the drop-down menu to select bottom or right.

Parameter Mapping
Parameter Mapping helps you refine your filters by letting you specify which dashlets and which parameters are

affected by a filter.

To open Parameter Mapping:
1. Open a dashboard with filters, such as the Sales Dashboard created in Creating a Dashboard, in the
Dashboard Designer.

2. Click -é to open Parameter Mapping.
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Parameter Mapping

Source Dashlet Filter/Parameter Dashlet Affected Filter/Parameter Affected
Country 04. Product Results by Store ¥ | | Country A + m
Filter Group Department 16. Interactive Sales Report ¥ | | Product_Department v + m
Type 16. Interactive Sales Report ¥ Product_Family v + m

Create New Filter

n Cantel

Figure 2-6 Parameter Mapping for the Sales Dashboard

Parameter Mapping displays the filter-to-dashlet mapping, and includes the following columns and buttons:

* Source Dashlet, the name of the dashlet where the filter originates. Can also display Filter Group
(multiple filters in a single dashlet) or Manually Created Filter (filter created using Parameter Mapping,
as described below).

« Filter/Parameter, the name of the filter.

« Dashlet Affected, with a dropdown menu including all dashlets that can be affected by that filter.

*  Filter/Parameter Affected, with a dropdown menu including all parameters associated with the
selected dashlet in the Dashlet Affected column.

+  Add button ¥, used to add additional dashlet/parameter combinations to a filter.

+ Delete button Il used to delete a dashlet/parameter combination.

From Parameter Mapping, you can add, delete, or edit an existing dashlet/parameter combination, and create a
new filter to add to the dashboard.

To add a filter using Parameter Mapping:

1.
2.

4.

Open a dashboard with filters, and open Parameter Mapping as described above.
In the filter row you want to add the new filter to, click + A row containing new affected dashlet and
filter/parameter dropdown menus appears.

Using these new line-items, select the dashlet and parameter combination you want to apply to the
dashboard.

Click OK to apply and save or Cancel to discard your changes.

To delete a filter using Parameter Mapping:

1.
2.

Open Parameter Mapping.

In the filter row you want to delete, click I . The filter row disappears from Parameter Mapping.

To create a new filter via Parameter Mapping:

1.

oo »

Open Parameter Mapping.

Click Create New Filter. A new row is added to the manager.

In the Filter column, enter a name for the new filter. Click outside the text box to apply the name.
Click ¥ and select the dashlet and parameter combination you want to apply to the new filter.

Click OK to apply and save, or Cancel to discard the new filter.
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To delete a newly-created filter:

1. In Parameter Mapping, click I in the filter row you want to delete. The Dashlet Affected and

Filter/Parameter affected dropdown menus disappear.

2. Click [ again in the row you want to delete. The Filter row disappears.

Click OK to apply and save, or Cancel to discard the new filter.

Creating a Dashboard

This section describes the creation of a simple dashboard.

To add a report or Ad Hoc view to a dashboard, you must have permission to view those elements.

To create a simple dashboard:

1. Click Create > Dashboard. The Dashboard Designer appears, displaying the list of available content and

the canvas.

2. In the Existing Content section of the Available Content panel, find report 16. Interactive Sales Report.

3. Click and drag the report onto the Dashboard Canvas.

Available Content New Dashboard
v New Content o) 9_ -~ A O =2 ou a2z
dll Cchart
|E=®| Crosstab
B[ Table
TT| Text
@ Web Page
ay Image

» Existing Content

13. Top Fives Report o
idg. Performance Sum...

14. Performance Summ...

14, Stop Light KPI

14, World Map

15g. Sales Gauges Report
15. Sales Gauges Report
16g. Interactive Sales R...

16. Interactive Sales Re...

17. Report Workbook
20.1 Account List 16. Interactive Sales Report

20.1 Account List

[EL)EL EY EY EY EN EY EY [ED

20.1 Account List
20.1 Account List
20.1 Account List

20.1 Account List

EY EY EY EY [EY EY ED B

20.2 Cities

» Filters

Figure 2-7 Dragging report onto Dashboard Canvas

4. 1In Available Content, find 04. Product Results by Store Type Report.

5. Click and drag the report onto the canvas, until the left half of the Interactive Sales Report turns orange.
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The Product Results by Store Type Report appears on the canvas, next to the Interactive Sales Report. Both
report dashlets are sized to fit side-by-side on the canvas.

Right-click the Product Results by Store Type Report and click Properties.
Use the Scale to Fit dropdown to select Dashlet.
Click OK. The resized Product Results by Store Type Report now displays the entire crosstab in the dashlet.

© x® N

Click and drag the report 05. Accounts Report onto the canvas, until the lower half of the Interactive Sales
Report turns orange.

The Accounts Report is placed under the Interactive Sales Report, and both dashlets are resized to fit on the
right half of the canvas.

10. In the Dashboard Designer toolbar, click % to open the Dashboard Properties dialog.
11. Deselect Show dashlet borders and click OK.

In Figure 2-8 you can see how the dashboard canvas looks at this point.

New Dashboard
O H « » » = 8 HE
04. Product Results by Store Type Report 16. Interactive Sales Report

Page |1 of 522 P pp Page |1 of 20 > b

Product Results by Storz Type
" : . Product Transaction Summary Report
Praducr name e 1 S T3 Stors Com 213 Lot Sk 5313
Product Family  Food
Product Department  Produce

Product Category  Vegetables

05. Accounts Report

Page |1 of 47 |
Accounts 10727115 L) iasrersor

B hame Phess Addrass

1 Burnaby, Canada

Figure 2-8 Simple Dashboard Canvas with three reports

12. Click 9 to preview the dashboard.

The end user view of the dashboard appears.

13. Click E to return to the designer

14. Click = =, then select Save Dashboard.

15. In the Save As window, change the default name, New Dashboard to sales Dashboard and locate a
folder, such as the /Dashboards folder.

TIBCO Software Inc. 35



JasperReports Server User Guide

16. Click Save.

2.3.1  Adding New Content

In addition to pre-existing reports and Ad Hoc views, you can create content for your dashboard directly from
the Dashboard Designer, including:

Charts
Crosstabs
Tables

Text

Web page links
Images

2.3.1.1 Adding Charts, Crosstabs, and Tables

The Dashboard Designer includes an on-board Ad Hoc Editor, which allows you to create charts, crosstabs, and
tables for your dashboard without leaving the designer environment.

Any chart, crosstab, or table you create within the Dashboard Designer is available only on the current
dashboard; otherwise, they function like standard Ad Hoc Editor-created versions of these elements. They are
saved as an Ad Hoc view and placed in a dashlet on your dashboard.

To add a new chart, crosstab, or table to your dashboard:

1.

In the New Content section of the Available Content panel, click and drag the type of element you want
to add to your dashboard (Chart, Crosstab, or Table) onto the dashboard canvas.

The designer's Ad Hoc Editor opens, and the Select Data dialog appears.

Browse to or search for the data source you want to use.

e Click Ee for a tree view of the files.

* Click
*  Use the text search field to locate a specific data source.

Depending on your selected data source, the remaining steps may vary. Follow the displayed instructions.
for more information about this process, see 4.1.1, “Ad Hoc Sources: Topics, Domains, and OLAP
Connections,” on page 84.

for a list view of the files.

When you complete the data source selection process, click OK. The Ad Hoc Editor opens.

The on-board Ad Hoc Editor works just like the standard editor. For information on working with the
editor, see Chapter 4, “Working with the Ad Hoc Editor,” on page 83.

When you finish creating your view, click = to save.

In the Save to Dashboard dialog, enter a dashlet name and click Save. The dashlet is added to your
dashboard.

2.3.1.2 Adding Text

You can add a text field dashlet for titles and instructional text.

To add a text dashlet:

1.

In the New Content section of the Available Content panel, click and drag the Text item onto your
dashboard. The Dashlet Text window opens.
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Enter the text you want to appear on your dashboard.
Click OK. The dashlet is added to your dashboard.

Edit the dashlet name and font appearance by opening the Properties dialog. See “Dashlet Properties” on
page 30 for more information.

2.3.1.3 Adding a Web Page

You can add a dashlet to display a web page on your dashboard.

To add a web page dashlet:

1.

In the New Content section of the Available Content panel, click and drag the Web Page item onto
your dashboard. The Dashlet URL window opens.

Enter the URL you want to appear on your dashboard.
Click OK. The dashlet is added to your dashboard.

Edit the dashlet name by opening the Properties dialog. See “Dashlet Properties” on page 30 for more
information.

2.3.1.4 Adding an Image

2.3.2

You can add a dashlet to display an image, such as a corporate logo, on your dashboard.

To add an image dashlet:

1.

In the New Content section of the Available Content panel, click and drag the Image item onto your
dashboard. The Dashlet URI window opens.

Enter the URI for the image you want to appear on your dashboard. Use the repo: syntax for images in
your repository.
Click OK. The dashlet is added to your dashboard.

Edit the dashlet name by opening the Properties dialog. See “Dashlet Properties” on page 30 for more
information.

Adding Controls to a Dashboard

The Interactive Sales Report was designed to be run with input controls. When you add a report that has input
controls to a dashboard, the controls don’t appear until you explicitly add them, one-by-one. The controls can
either be added directly to the dashboard as a dashlet or accessed from the toolbar as a pop-up window. When
the report runs, dashboard users provide input using the control. Data based on the user input appears in the
dashboard. For example, using the input control, you select Mexico. The report on the dashboard shows orders
from Mexican companies.

To add controls as a dashlet:

1.

If the Sales Dashboard created in Creating a Dashboard is not open, locate the /Dashboards folder in the
repository. Right-click the dashboard name and select Open in Designer from the context menu.

The Sales Dashboard appears in the designer, as shown in “Simple Dashboard Canvas with three
reports”, and the input controls available appear in the Filters section of the Available Content panel.

In the Filters section, expand the 16. Interactive Sales Report folder.
The input controls associated with the Interactive Sales Report appear.

Drag the Country input control onto the canvas, and place it above the Product Results by Store Type
dashlet.
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The Country input control and its label appear above the Product Results by Store type report on the
canvas.

4. Drag the Product Family and Product Department controls onto the Country input control dashlet. These
input controls are added to the same dashlet. Resize the dashlets as needed to view all of the input controls.

Click H. and select Save Dashboard, then click 0 to preview the dashboard.

6. Click in the Country text box to display the available countries. In this input control, you have the
following options:

*  The three countries: Canada, Mexico, and USA.
+ ¥ All, which selects all available values in the input control.
. % None, which deselects all available values in the input control.

« F Invert, which deselects any selected values, and selects the unselected values.

7. Use the options to select Mexico from the values list, and click Apply at the bottom of the dashlet. The
data displayed in the Interactive Sales Report changes, but is not updated in the other reports, as they do
not have an input control named Country.

8. Click E to return to the Dashboard Designer.

You can also change the labels, or display names, of individual input controls and filters within a dashlet.

To rename an input control or filter:
1. With the Sales Dashboard open in the Dashboard Designer, right-click Product Family in the input control
dashlet, and select Properties. The Filter Properties dialog opens.

2. Change the Filter Label from Product Family to Type, and click OK.

3. Right-click the Product Department input control and select Properties. Change the Product Department
filter label to Department, and click OK. The input control labels are updated.

Parameter Mapping

Source Dashlet Filter/Parameter Dashlet Affected Filter/Parameter Affected
Country 04. Product Results by Stare T Country v + m
Filter Group Department 16. Interactive Sales Report ¥ | | Product_Department v + m
Type 16. Interactive Sales Report ¥ | | Product_Family M + m

Create New Filter

n cancel

Figure 2-9 Parameter Mapping for the Sales Dashboard

To add controls as a pop-up window:

With the Sales Dashboard open in the Dashboard Designer, click % to open Dashboard Properties.
2. Select Show filter dashlet as pop-up and click OK.

The input controls dashlet disappears from the dashboard and Y appears on the toolbar. This button is
also displayed when you're viewing the dashboard.

38 TIBCO Software Inc.



Chapter 2 Working with Dashboards

3. Click = = and select Save Dashboard, then click @ to preview the dashboard.

4. Click Y to view the filter pop-up window.

Like the dashlet, selecting the options in the pop-up changes the data displayed in the Interactive Sales
Report.

5. Click - to close the filter pop-up window.

6. Click E to return to the Dashboard Designer.

2.3.3 Refining a Dashboard’s Layout
After completing the layout, refine the look and feel of the dashboard.

To refine the dashboard’s layout:

1. Ifit isn’t open, locate the Sales Dashboard you created in Creating a Dashboard, typically in the
/Dashboards folder.

2. Right-click the dashboard name, select Open in Designer from the context menu
When the dashboard opens in the designer, click Preview.
The end user’s view of the dashboard appears.
4. In the Country field, select a new value.
The reports do not update because the dashboard includes the Apply button.
Return to the Dashboard Designer and on the Country filter dashlet, right-click and select Properties.
Deselect Show Apply button, and select Show Reset button.
Click Apply.
The dashlet's Apply button disappears, and the Reset button appears.

8. Reposition the Reset button to the right side of the dashlet using the Position of dashlet buttons drop-
down menu. Click OK.

9. Click Preview. The end user view of the dashboard appears.
10. Change the value in the Country input control. The dashboard reflects the change immediately.

11. Return to the Dashboard Designer and click Save > Save Dashboard. The dashboard is saved to the
repository.

2.4 Specifying Parameters in Dashlets

You can add parameters to dashlet names, text dashlets, web page dashlets, and hyperlinks in chart dashlets.
When you add a parameter, you must map a filter in the dashboard to the parameter. See Mapping parameters
in Parameter Mapping for more information.

Simple parameters:
For text dashlets, web links, and dashboard names, use the syntax $P{parameter name} to directly pass the
parameter value to the web page. Examples:

* In a text dashlet, enter the parameter in the Text box:
Product Family: $P{Product Family}
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* In a web page dashlet or a web link in a chart dashlet hyperlink, enter the parameter in the Web Page
Address (URL) text box:
http://en.wikipedia.org/wiki/$P{Customer Country}
* In a repository or web URI for an image dashlet, enter the parameter, enter the parameter in the Web
Address/Repository URI text box:
repo:/public/Samples/Reports/$P{Customer Country}/flag.png
* Dashlet name: Enter the parameter in the Dashlet Name box:
Unit Sales for $P{Product Family}

For repository hyperlinks in a chart dashlet, use the syntax ?filter in target=$P{dashlet param}. For
example, the following link sets the ¢_country 1 input control in the 05. Unit Sales Trend report to the value of
a Store Country parameter in the dashlet.

repo:/public/Samples/Reports/05. Unit Sales Trend?c country 1=$P{Store Country}

To find the correct name for a filter in a target resource, open the Dashboard Designer in a new
window, and add the resource to the canvas. Then expand the resource's folder in the Filters panel
and hover over the filter whose name you want to see.

Parameters in multi-valued input controls:

For multi-valued input controls, you can define a separator for the input control values:

*  For text dashlets, web links, and dashboard names, use the syntax $P{parameter name ? "separator"}. The
following example in a text box displays results like Product Family: Drink + Food:

Product Family: $P{Product Family ? " + "}

*  For repository links in a chart or image dashlet, use the syntax ?$P{"filter in target=", dashlet
param, 2 "&"}.For example, the following link allows multi-select with the ¢_country 1 input control in
the 05. Unit Sales Trend report:

repo:/public/Samples/Reports/05. Unit Sales Trend?$P{"c country 1=", Store
Country, "&"}

When Mexico and USA are selected, this expands to the following link:
repo:/public/Samples/Reports/05. Unit Sales Trend?c country l=Mexico&c_ country 1=USA

2.4.0.1 Mapping parameters in Parameter Mapping

After you have created a parameter, create a mapping for it as follows:
Mapping parameters in dashboard names and text, image, or web page dashlets:

1. In the Dashboard Designer, click -EE to open Parameter Mapping.

2. In the filter row where you want to add the new filter, click +*. A row containing new affected dashlet and
filter/parameter dropdown menus appears.

3. Using these new line-items, select the dashlet where you added a parameter, then select the parameter.

4. Click OK to apply and save or Cancel to discard your changes.

Mapping parameters in chart hyperlinks:

To have JasperReports Server create a parameter mapping automatically:

1. In the Dashlet Properties dialog box for your chart, use one of the names in the Available parameters list as
the name of your parameter.
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2.4.1

2. Click OK to close the dialog box and create the mapping.

To create a mapping in Parameter Mapping:

1. In the Dashlet Properties dialog box for your chart, click Create Links in Parameter Mapping... to open
Parameter Mapping.

2. In the filter row where you want to add the new filter, click *. A row containing new affected dashlet and
filter/parameter dropdown menus appears.
Using these new line-items, select the dashlet where you added a parameter, then select the parameter.

4. Click OK to apply and save or Cancel to discard your changes.

Creating a Web Page Dashlet

When working with Web Page dashlets in the Dashboard Designer, you can include a parameter reference in the
dashlet's URL. The parameter references an existing filter in another dashlet, and uses that filter to display a
specific web page relevant to the filtered information.

The following example takes you through the steps for creating a simple dashboard in the Dashboard Designer,
adding a sample chart with geographic filters, and creating a Web Page dashlet that displays a Wikipedia page
for the country the sample chart is filtered on.

First, create the simple dashboard:
1. 1.Log in to JasperReports Server as superuser.
2. Click Create > Dashboard.
The Dashboard Designer appears, displaying the list of available content and the canvas.
3. In the Existing Content section of the Available Content panel, find report 06. Sales Mix by Gender.

4. Click and drag the report onto the Dashboard Canvas. Note that the Filters section now includes the Sales
Mix by Gender chart.

Next, add the filter input control to the dashboard:
1. In the Filters section, expand the 06. Sales Mix by Gender folder.

The input controls associated with the Sales Mix by Gender Report appear.
2. Drag the Customer Country input control onto the canvas.

Now, add the Web Page dashlet with the parameter reference and add it to the filter:

1. In the New Content section of the Available Content panel, click and drag the Web Page item onto
your dashboard.

The Dashlet URL window opens.
2. Enter the following URL:
http://en.wikipedia.org/wiki/$P{Customer Country}

Click OK.
Right-click the dashlet and select Properties.
Change the Dashlet Name to Wiki.

6. Click -EE to open Parameter Mapping.
7. In the Customer Country filter, click .

A row containing the new affected dashlet and filter/parameter dropdown menus appears.
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In the Dashlet Affected column, select wiki from the

dropdown menu.
10. Click OK.

Finally, preview the new dashboard functionality:

1. Click @ to preview the dashboard.

new Select dashlet... dropdown menu.

In the Filter/Parameter Affected column, select Customer Country from the new Select parameter...

Click in the Customer Country text box to display the available countries.
3. Select Mexico from the values list, and click Apply

at the bottom of the dashlet. The data in the Sales Mix

by Gender report is updated to display only information about Mexico, and the wiki dashlet displays the

Wikipedia page for Mexico.

In Figure 2-10 you can see how the dashboard canvas looks at this point:

Sales by Gender Dashbeoard E H.

wiki
Customer Country

Available: 3 Selected: 1 Create account Login
Q

Canada Article Talk Read View scurce View history Q
usa N Mexico -

al WIKIPEDIA

X None B Invert The Free B lopedi . .
. R From Wikipedia, the free encyclopedia
m Main page This article is about the country in North America. For other uses, see
Contents

Featured content
Current events
Random article
Donate to Wikipedia
Wikipedia store
Interaction

Help

06. Sales Mix by Gender

Mexico (W3 meksikou/; Spanish:
Mexico [ mexiko] (4 listen)), officially
the United Mexican States
(Spanish:

Mexico (disambiguation).

United Mexican States
Estados Unidos Mexicanos

Mexico, Food

Mexico, Non-Consumable

0 10 20 30 40

HF

Figure 2-10 Dashboard with web page parameters

4. Click E to return to the Dashboard Designer.

5. Click E = then select Save Dashboard.

50 60 70 80 a0 100

HM

6. In the Save As window, change the default name, New Dashboard to Sales by Gender Dashboard and

locate a folder, such as the /Dashboards folder.
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7. Click Save.

2.4.2  Adding a Hyperlink to a Chart Dashlet

When working with chart dashlets in the Dashboard Designer, you can specify a link that opens when a user
clicks the dashlet. You can optionally include a parameter which references an existing filter in another dashlet,
and uses that filter to display a specific web page relevant to the filtered information.

The following example takes you through adding a hyperlink to the chart dashlet in the Sales by Gender
dashboard created in 2.4.1, “Creating a Web Page Dashlet,” on page 41. The example also shows how to add
a parameter to a hyperlink.

First, open the dashboard:

1. If the Sales by Gender dashboard created in 2.4.1, “Creating a Web Page Dashlet,” on page 41 (above) is
not open, locate the /Dashboards folder in the repository. Right-click the dashboard name and select Open
in Designer from the context menu.

The Sales by Gender Dashboard appears in the designer.

Create a chart hyperlink:

1. Right-click on the Sales Mix by Gender dashlet and select Properties....
The Dashlet Properties dialog box opens.

2. Click the Hyperlinks tab.

Dashlet Properties

Basic Hyperlinks

Chart Hyperlinks:
#| Enable chart hyperlinks
Action:

Open new page ¥

Web Address/Repository URI:

repo:/public/Samples/Reports/04._Product_Results_by_Ston
Repasitory URI must start with repo:
Available parameters:

Measures

Customer Gender

Product Family

Store Country

Create Links in Filter Manager...

m oK Cancel

Figure 2-11 Hyperlinks tab in Dashlet Properties

3. Click Enable chart hyperlinks to select it.
4. Choose Open new page from the Action menu.
The Web Address/Repository URI entry bar is displayed.
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5.

6.

Enter repo: /public/Samples/Reports/04. Product Results by Store Type Report for the Web

Address/Repository URI.

To see the report's path, hover over the report's name in the Existing Content pane.

Click OK.

Preview the new dashboard functionality:

Click Q to preview the dashboard.

Click the chart dashlet.

The 04. Product Results by Store Type Report opens in a new tab.

Click E to return to the Dashboard Designer.

Add a parameter:
Right-click on the Sales Mix by Gender dashlet, select Properties..., and click the Hyperlinks tab.
The Available Parameters area shows the parameters available in the chart.

1.

Modify the URL to add a parameter that provides a value for an input control in the target report:

You need to know the correct name of the input control in your target report. In this case it is sales
store store contact store country 1 in the 04. Product Results by Store Type Report.

Create a parameter. If you create a parameter name, it is helpful to use a name that is not used in
Parameter Mapping. In this example, use LinkCountry. For more information about parameters, see 2.4,
“Specifying Parameters in Dashlets,” on page 39.

The link is as follows:

repo:/public/Samples/Reports/04. Product Results by Store Type Report?sales
store store contact store country 1=$P{LinkCountry}

If you use one of the names in the Available Parameters list, the mapping to the parameter is created for
you. In this example, if you use Store Country instead of LinkCountry, you do not need to create links
in Parameter Mapping.

This example does not show how to add support when more than one country is selected. For more
information, see 2.4, “Specifying Parameters in Dashlets,” on page 39.

Click Create Links in Parameter Mapping. Click Yes when prompted.
Parameter Mapping is displayed.
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2.5

Parameter Mapping

Source Dashlet Filter/Parameter Dashlet Affected Filter/Parameter Affected
Customer Gender +
Measures +
06. Sales Mix by Gender
Product Family +
Store Country +
06. Sales Mix by Gender v Customer Country v m
Filter Group Customer Country Wiki v | [Customer Country v m
06. Sales Mix by Gender v Link Country v + m

Create New Filter

n Cancel

Figure 2-12 Parameter Mapping

7.

In the Customer Country filter group, click +
A new row with affected dashlet and filter/parameter drop-down menus appears.

In the Dashlet Affected column, select 06. Sales Mix by Gender from the new Select dashlet... drooping
menu.

In the Filter/Parameter Affected column, select LinkCountry from the new Select parameter... dropdown
menu.

Click OK.

Finally, preview the new dashboard functionality:

A WD =

Click G to preview the dashboard.

Click in the Customer Country text box to display the available countries.

Select Mexico from the values list, and click Apply at the bottom of the dashlet.

Click the chart dashlet.

The 04. Product Results by Store Type Report opens in a new tab.

To verify that the parameter has been passed correctly, click in E the 04. Product Results by Store Type
Report.

The Input Controls dialog box opens, with Mexico set.

Return to the tab that contains your dashboard.

Click E to return to the Dashboard Designer.

Click E = then select Save Dashboard.

Editing a Dashboard

You can edit a dashboard if you have the proper permissions.
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2.6

To edit a dashboard:

1.

Select View > Repository and search or browse for the Dashboard you want to modify.
By default, the repository includes the /Dashboards folder where you can store dashboards.

Right-click the dashboard and select Open in Designerfrom the context menu. The designer appears,
displaying the dashboard.

Edit the dashboard by adding, removing, resizing, or dragging content.

For more information about working with dashboard content, see “Creating a Dashboard” on page 34.

When you are satisfied with the dashboard, hover your cursor over = ~ and select Save Dashboard. To
create a new version of the dashboard, select Save Dashboard As and specify a new name.

Exporting a Dashboard

You can create a snapshot of a dashboard and save it on your computer. Exporting a dashboard requires the
following:

The export button has been enabled for the dashboard. See “Dashboard Properties” on page 28 for more
information.

Phantoml]S is installed on the computer hosting JasperReports Server. For information on configuring
Phantom]JS for dashboards, see the System Configuration chapter in the JasperReports Server Administrator
Guide.

To export a dashboard:

1.
2.

3.

Select View > Repository and search or browse for the Dashboard you want to export.
Click the link to open the dashboard.

|9
Hover your cursor over B and select the export format from the drop-down list.

The available formats are:

* PNG

« PDF

« DOCX
* ODT

Save the dashboard in the export file format, for example PDF, or open it in the application.

If you export a dashboard while a dashlet is reloading its content, the dashlet will appear as a grayed-out

box in the exported file.

2.6.1 Localizing Controls
You can design dashboard controls to accommodate different languages. First, use the $R syntax to define
prompts and static lists of values. Next, attach resource bundles to the report that contain translations of the
prompts and lists of values. Finally, add the report to the dashboard. For more information about how to localize
input controls, see “Localizing Reports” on page 184.
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2.7

2.7.1

2.8

Tips for Designing Dashboards

Charts and small crosstabs are best suited to dashboards. However, you can design table reports that work well
in the dashboard. Such reports tend to be very narrow and are typically used with input controls to limit the
number of rows they return.

Keep reports small because dashboards typically contain more than one. In particular, reports shouldn’t be too
wide, as horizontal room is always at a premium in a dashboard. The server strips margins from an Ad Hoc
report when displaying the report on a dashboard.

Input Control Tips

When designing input controls for a dashboard, keep these guidelines in mind:

* To pass a value to an external URL, the URL Parameter Name you give to the input control must match
the name of a parameter that the URL can accept. The value of the input control must also be a value the
URL can accept. The target URL is likely to have additional requirements and limitations. For example, the
name of the parameter may be case-sensitive; in this case, the value you enter in the URL Parameter
Name field is also case-sensitive.

The input control must pass data that the URL can accept. Otherwise, the server may be unable to retrieve the
correct data from the external URL.

Viewing Legacy Jaspersoft Dashboards

This section refers to legacy dashboards, those created in JasperReports Server version 5.6.2 and
earlier.

Dashboards created prior to JasperReports Server version 6.0 open in their respective versions of the Dashboard
Designer. The following procedure shows you some of the features of legacy dashboards. For more information
about the features available for legacy dashboards, see the edition of the JasperReports Server User Guide
corresponding to the version of JasperReports Server where the dashboards were created.

To view a legacy dashboard:

1. Open your dashboard for viewing. This example uses the SuperMart Performance dashboard, one of the
samples in an earlier version of JasperReports Server. Although this dashboard may not be available in your
version of JasperReports Server, other legacy dashboards are similar.

The SuperMart dashboard includes three reports:
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SuperMart Dashboard

Monthly Sales by Quarter Revenue and Profit

Customers

All States California Crregon

Select a state to change the report view
Washington

5 130,628

For State = All States

@2 ek G4

545539 Apr §42878 Jul § 50,246 Oct 5 42,342
§44,058  May $ 44,456 Aug §46,199 MNow § 53,363
§50,029  Jun §45331 Sep §43,825  Dec § 56,965

5 132,866 5140,271 5152671

Key: Low Value High Value

1.  Mary Francis Benigar 51078
2, Wilden Cameron 3 280
3. Ida Rodriguez 5948
4. James Horvat %928
5. HKristin Miller 3878
Promotions
1. High Roller Sawings 55575
2. Cash Register Lottery 54,475
3.  You Sawve Days 54141
4. Saving Days 53.058
5. Big Promo 52,741
Products
1. Hermanos Green Pepper 5922
2. Just Right Rice Soup 5 853
3.  Urbkan Small Eggs 5 845
4.  Washington Apple Drink 3 835
5. Carlson Head Cheese 5821

o = = = = o o = o

[} ] =3 m 3 =1 3 [ g 5] [}

w = = a1 =4 m = [s]
Ravenus Profit

Figure 2-13 SuperMart Dashboard Example

4.
3.

When done, click View > Repository to go to the repository page.

Keep these points in mind when viewing a dashboard that has input controls:

Start Month  January -

End Month  December

Reset = Submit

5 .
When you hover over a report, controls appear for that report: Click Refresh to refresh the report
content, and click Open in a new window to open the report in a new window.

Select new values from the Start Month and End Month drop-downs and click Submit to change the data
displayed. All three reports update to display data for the months you indicate.

Click Reset to set the input controls to the last values saved and return the dashboard to its initial view.

An input control may appear as a text field, a drop-down, a check box, a multi-select list box, or a calendar

icon.

If one of the frames in a dashboard does not refer to an input control, that frame does not update when you
change that input control’s value. Only reports that refer to the input control reflect the change.

If a dashboard includes a Print View button, click it to display the dashboard without JasperReports
Server's header and footer. Depending on your web browser, this may also open your browser's Print

window.
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3.1

3.1.1

JasperReports Server makes it easy to run reports. When you run a report, it opens in the interactive Report
Viewer. With the Viewer, you can personalize and refine the displayed report data. If the report has input
controls, you run the report with one set of data and then another. Using the report scheduler, you can run
reports repeatedly and unattended during off hours or at other times.

This chapter contains the following sections:

*  Overview of The Report Viewer

*  Running or Creating a Simple Report

*  Running a Flash Chart

*  Running a Report with Input Controls or Filters
*  Scheduling Reports

* Event Messages

The tutorials in this chapter and throughout this guide assume you’ve installed the sample data provided with
the server.

Overview of The Report Viewer

The Report Viewer allows you to view a report, export content to various output formats, and apply formatting,
sorting, and filters to control how the data is displayed.

This section describes the functions available in the Report Viewer. You can find more detailed information
about using this functionality throughout this chapter.

To open a report in the Report Viewer:
1. Locate your report in the library or repository.

2. Click the report name, or right-click the report name and select Run. In the repository, you can also click
the report row and select Run from the tool bar. The report opens in the Report Viewer.

The Report Viewer Tool Bar

The Report Viewer tool bar contains a number of controls for working with your report. These controls are
described in Table 3-1.
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Table 3-1 Report Viewer Tool Bar Icons

Icon Name Description

Refresh Click to refresh the report data from the data source.

£ )
report with
latest data

44 First Click to jump to the first page of the report.

« Previous Click to go to the previous page in the report
Current Shows the number of the currently displayed report page.

Page |1 of 47

Page

" Next Click to go to the next page in the report.

M Last Click to jump to the last page of the report.

= Zoom Out Click to zoom out on the report.

o Zoom In Click to zoom in on the report

100, [ | Zoom Click this icon to open the Zoom Options drop-down menu.
Options
Pl Search Enter your search term here to find a text string in your report. Click the
drop-down menu to toggle search preference settings.

e | Search Click to jump to the previous instance of the search term.
Previous

| Search Next | Click to jump to the nextinstance of the search term.

S Back Exits the Report Viewer and takes you to the previous screen.
ac
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Icon Name Description
Save Place the cursor over this icon to open a menu of save options.
Export Click to export the View into one of the available formats.
Undo Click to undo the most recent action.
e,
Redo Click to redo the most recently undone action.
-
Undo All Click to revert the report to its most recently saved state.
'3
Input Click to see the input controls applied to this report. For more
E Controls information, refer to “Simple Input Controls” on page 65.
Bookmarks Click to display the Table of Contents pane. This pane is available only
— on reports with enabled Bookmarks.
|

3.1.2 Column Menu

Reports that contain table components are enabled for user interactivity. Table components are defined in
Jaspersoft Studio or from Ad Hoc Views. When a table is enabled for interactivity, column formatting, filtering,
and sorting are managed from a menu displayed by clicking the column you want to apply changes to. These
menu icons are described in Table 3-6.

Table 3-2 Column Formatting Icons

Icon Name Description
Formatting/Show column/Hide column Select Formatting to open the Format Column box.
i Select Show column or Hide column.
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Icon Name Description
Column filters Click to open the Filter column box.
Y
Sort ascending Click to sort fields in the selected column in ascending
4 order.
Sort descending Click to sort fields in the selected column in ascending
order.
¥
Column size Click and drag this icon to make columns wider or
v narrower.

3.1.3  Data Snapshots

Some reports have an optional data snapshot feature enabled. A data snapshot is a cached copy of the data
included in a specific report. Data snapshots allow you to access a report's data (including input control
settings) without having to retrieve it from the data source, which in some cases can save a significant amount
of time.

When a report is opened in the Report Viewer, data is retrieved from the data snapshot. If the snapshot does not
exist, then a live query is made to the data source. A snapshot is created when a report is saved from the viewer,
or via the scheduler. The Report Viewer Ul displays a date and time stamp that indicates when the report data
was last refreshed with live source data.

The system administrator can enable or disable the data snapshot feature.

It should be noted that a report can have only one snapshot. For instance, if you edit and save a report that
already has a snapshot associated with it, a new snapshot overwrites the previously-created snapshot.

3.2 Running or Creating a Simple Report

You can view and work on a report in the Report Viewer in a number of ways:

* Running an instance of an existing report
* Creating a new report from an existing Ad Hoc view

3.2.1 Running a Simple Report

This section describes how to run a tabular report that lists account data.

To run a report:
1. Log into the server as an administrator, such as jasperadmin.
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3.2.2

2. On the Home page, click View list in the Reports block.

The search results appear, listing your own files and other files that your user account has permission to

vi

ew. If you log in as jasperadmin, 05. Accounts Report appears in the search results.

i Filters Repository Sort By: Name | Modified Date

® All available Al + Reports

Modified by me ©)] Mame Description Type Created ... Modified ..

WL L I 03. Store Segment Performan... Sample OLAP chart with HTMLS Grouped Bar ... Report May 7 4/25/2014

04. Product Results by Store ... Sample Filtered Table Report Showing Multipl.. Report May 7 5/15/2014

All types 05. Accounts Report Basic interactive Table Component report with... Report May 7 4/17/2014

*® Reports 05g. Accounts Report Basic interactive Table Component repart with... Report May 7 10/3/2013

Report outputs 06g. Profit Detail Report Sample report containing containing interactiv... Report May 7 5/13/2014

More choices. 06. Profit Detail Report Sample report containing containing interactiv... Report May 7 5/13/2014

07g. Revenue Detail Report Sample report containing containing interactiv... Report May 7 5/13/2014

Figure 3-1 Search Results Listing

3. To run a report, click the name of a report in the repository. For example, click 05. Accounts Report. The
report appears, as shown in Figure 3-2.

05. Accounts Report  Data refreshed May 13, 2015 at 11:16:43 AM 3

Back H. BE. n - 4 100% * Q -~ 4 p Page 1 of 47 P M
Accounts 05/13/15 )JASPERSOFT
# Mame Phone Address

1 Burnaby, Canada

Souza-Quick Construction Group £20-555-8963

2 suffin-Cleary Enginesring, Ltd 367-555-1366

3 L&EGillmors Communications Partners 203-555-9531

4 NE&OGarner Electronics, Inc 472-555-1111 P
Orona-Warmack Transportation, inc 258-555-5742 165 Schenone Court

&  D&Z McLaughlin Electronics, Ltd §02-555-8145 661 Miller Ave.

7 Q & P Dodd Telecommunicatio 810-555-3241 5684 San Marino Ct.

8 F&Xwelington Communicati 210-555-7617 4ps5 Hitcheock

8 Ratcliff-Moss Electronics, Lid 721-555-7412 4776 Kentucky Drive

10 Rosemont-McMenama Engineering, Ltd £75-555-1134 6228 Meadowhrook Dr.

Figure 3-2 Output of the Accounts Report

If you are running a report with multiple pages, the first page of the report appears before the entire report
is loaded. You can begin scrolling through report pages as they load, as indicated in the pagination
controls in the upper left corner of the Report Viewer.

If you want to cancel loading the report before itis complete, click the Cancel Loading button that appears
next to the pagination controls.

Creating a Report

You can create a report directly from the Jaspersoft Server Home page. This method allows you to select an
existing Ad Hoc view and generate a report from it, without going through the Ad Hoc Editor.

To create a report from the Home page:

1. On the Home page, click Create in the Reports block. The Create Report wizard opens.
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3.2.3

2. Select the Ad Hoc view you want to use as the basis for your report.

3. Select a report template. To use a template other than the default, select Custom Report Template, click
Browse and select the desired template. See 3.2.3, “Report Templates,” on page 54 for more information.

4. Click OK. If asked, enter the input controls needed. See “Using Input Controls” on page 143.

You can now begin working with your report.

Report Templates

When you create a report, the Create Report wizard displays layout options for generating and exporting the
report:
+ Default Report Template applies basic layout options to your report. This is usually the Actual Size
template.
+ Custom Report Template allows you to browse to an existing template. JasperReports Server includes a
number of templates are available by default, including:
* A4 Landscape
* A4 Portrait
*  Actual Size
*  Letter Landscape
*  Letter Portrait.
Other report templates may be available. Report templates can be created in Jaspersoft Studio and uploaded
to JasperReports Server.
* Report Generator allows you to create a highly customized report design. This option is not often
enabled. See your JasperReports Server administrator for more information.

Most commonly, you will choose Default Report Template.

3.2.3.1 Using Report Templates for PDF

3.3

If you are exporting your report to PDF, choose your option based on the size of the output.

*  For most PDF exports, you can use Actual Size, which supports a maximum size of 14400px by 14400px.

»  For reports with an output height exceeding 14400 px, use a paginated report template that is wide enough
for your report. For example, if you have a long report with width less than 842px, you can use the
paginated A4 Landscape theme. A report designer can create additional custom templates in Jaspersoft
Studio. contact your administrator for more information.

*  Reports with output width exceeding 14400 px will be truncated in PDF. Redesign your report or use a
different export format.

Getting New Perspectives on Data

The report shown in Figure 3-2 was created using the Ad Hoc Editor. As this type of report runs, you can
interact with it in the Report Viewer to visualize the data in different ways. Column formatting allows you to
highlight certain columns and fields, and filtering and sorting report output on-the-fly can provide timely views
of the data that answer your questions. For example, suppose you’re running the Accounts Report and want to
know how many accounts have offices nearby. Highlighting the phone number column with red text and
filtering it to show only accounts in your area code would reveal this data.
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3.3.1  Column Formatting

You can customize the basic formatting of column headings and fields, using the Format Column dialog. Hover

over - and click Formatting... The Format column dialog appears.

Format column: Store Name Basic Formatting Conditional Forrmatting

Apply to:
Headings

Heading text:

Store Name

Font: Size! Style:

DejaVu Sans 1z -g- _{

<
I
4

o 11 o

oy Sars 3 |
Dejavu San: Maono 13 alignment:
D ejavfu S erif 14 | B ==
Monospgced 15 =l BeI=EI=
SanzSerif &7 16 ils

< Previous Column Next Column > “ Cancel

Figure 3-3 Format Column Dialog

You can alter a column’s basic formatting or apply conditional formatting to a column.

In longer reports, columns have floating headers. If your report extends past your browser frame, use the
vertical scroll bar to move up and down the list. If you do not see a vertical scroll bar, try increasing the
width of your browser window.

This section discusses how to apply formatting to column headings and values. For information on conditional
formatting, see “Conditional Formatting” on page 56.

Column formatting options include:

e Text

*  Font type, size, and style

*  Background color

»  Font color

*  Text alignment

To customize your column formatting:
1. Run your reportt, so it opens in the Report Viewer.

2. Click the column you want to format.

Hover over M~ and click Formatting...
4. Click the Basic Formatting tab, and change the following options if needed:

Apply to — Select the part of the column you want to apply the formatting to.
* Heading text — Type new heading text to replace the current text.

*  Font - Scroll through the menu to select a font.

»  Size — Scroll through the menu to select a font size.
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3.3.2

+ Style — Click to select Bold, Italic, or Underlined text.
+ Background Color — Click to open the background color picker, then click to select the background
color.
*  Font Color — Click to open the font color picker, then click to select the text color.
« Alignment — Click to select Left, Center, or Right alignment.
5. Ifneeded, click Previous Column or Next Column to change the formatting for an adjacent column.

6. Click OK.

Conditional Formatting

The Report Viewer allows you to format column headings and fields, to highlight data that meets specific
criteria. For instance, if you want to call out fields for store sales above $100,000, you can do so by applying
text and background formatting to those stores that meet those numbers.

With conditional formatting, you can apply the formatting options listed in “Column Formatting” on page 55.
However, it is a slightly more complex process than applying formatting options to entire columns. This section
describes those complexities, including:

*  Condition hierarchy

*  Condition button states

*  Applying conditional formatting

3.3.2.1 Condition Hierarchy

If you have multiple conditions applied to a single field, their order will affect how they function. Conditions
are read and applied from bottom to top, and the topmost condition overrides the one(s) below.

For example, imagine you have more than one condition applied to the same format element: red text for all
stores over 20,000 square feet, and blue text for all stores over 30,000 square feet. As shown in “Condition
Hierarchy Example” on page 57, placing the formatting rule for stores over 20,000 above the rule for stores
over 30,000 causes the topmost rule to override the one below:
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Store Locations
Format column: Sales Basic Formatting | Conditional Formatting Store Name Store Trpe 50rT
Apply to on
Detail Rows - Etora 11 Supemarket 20,319
Conditions List el
# Operator Condition Format i
~tan 20,22
1 [Greater than 20,000 BiJ U |A, a W
2 [Greaterthan 30,000 BiJ Ud A. a VW
Add
25,
< Previous Column Next Column > “ Cancel st 23 i
Store Locations
- Store Hame store Type sQrT
Format column: Sales Basic Formatting | Conditional Formatting Lt
apply ta: Erore 1
Detail Rows - Srore 1
Conditions List LoE
# Operator Conditi Format s
ore 3
1 [Greater than or equal to_[=] 20,000 Bil U i|A, AV
2 [Grester than or equal to || 30,000 Bi 7 U &-iA AV are
Add
< Previous Column Next Column > m Cancel

Figure 3-4 Condition Hierarchy Example

3.3.2.2 Condition Button States

Because conditions higher up in the hierarchy can affect those below, the font style selection buttons each have

three states:

* Unchanged, which means it inherits the previous condition-based style, if any.

+  Set, which means the style is applied to text that meets the condition.

* Not Set, which means the style is not applied to the text that meets the condition, and is removed if a
conflicting condition lower in the conditional formatting hierarchy has marked that style as “Set”.

By default, the buttons are in the “Unchanged” state. Clicking the buttons toggles you through the three states.

See “Style Button States” for examples of the style button states.

Table 3-3 Style Button States

Unchanged Set Not Set
Bold
B B B
Italic
I el /
Underline
U u U
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The background and font color pickers have buttons for similar states, but these states behave slightly

differently:

* Unchanged, which means the field inherits the previous condition-based color, if any.

*  Set, which means the color is applied to text or background of the field that meets the condition.

* No Fill (background only), which means no color is applied to the background that meets the condition.
Regardless of conditions lower in the hierarchy, the background inherits the table’s default color.

Both have two buttons at the top of the window, along with the color selection boxes.

You control these states through the background color picker and the font color picker windows, using the
following buttons:

* No Fill (background only), which applies the No Fill state described above.
* Reset, which returns the text or background to the Unchanged state.
* The color selection boxes, which apply the Set state.

See “Color Picker Button States” for examples of the color picker button states.

Table 3-4 Color Picker Button States

Unchanged Set No Fill
Background Color
S &, &,
Text Color N/A
A r i‘

3.3.2.3 Applying Conditional Formatting

You apply conditional formatting much like you do standard column formatting, as described in “Column
Formatting” on page 55 with the extra step of creating the condition by which the formatting is applied.

To create a condition:
1. Run your report, so it opens in the Report Viewer.
2. Click the header or field of the column you want to format.

Move your mouse over f- and click Formatting...
4. Click the Conditional Formatting tab. The Conditional Formatting options appear:
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3.3.3

Format column: Region Basic Formatting Conditional Formatting
Apply to:
Detail Rows -
Conditions List
#* Operator Condition Format
Add
< Previous Column Mezxt Column > “ Cancel

Figure 3-5 Conditional Formatting Tab

10.

In the Apply to box, select the part of the column you want to apply the formatting to.
Click Add. This adds a line item in the Conditions List.
Fill in the following information:

*  Operator: Use the drop down menu to define how the condition is compared to the column data.

» Condition: Enter the condition criteria.

*  Format: Select the formatting applied to fields meeting the defined condition. Take care setting the
button states, as described in “Condition Button States” on page 57.

Repeat if needed to add multiple conditions to a column.

If you have multiple conditions, you may want to reorder them, to ensure they do not conflict with each

A v .. . .
other. Use the and to move conditions in the hierarchy.

If needed, click Previous Column or Next Column to change the conditional formatting for an adjacent
column.

Click OK. The condition is applied to the column.

Interactively Filtering Report Output

If the report output contains more information than you want, interactively filter it to display just what you
need. You conditionally filter report output by first selecting the column to use as a basis for filtering. Next,
you enter a filter condition, then a value for comparison. The server compares each field of the column to the
value that meets the condition. In Table 3-5 you can see the conditions available for each type of column:
numeric, date, and text.

Table 3-5 Interactive Filtering Conditions

Numeric Date Text

Equals Equals Equals

Does not equal Is not equal to Is not equal to
Greater than Is between Contains
Greater than or equal to Is not between Does not contain
Less than Is on or before Starts with
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Numeric Date Text

Less than or equal to Is before Does not start with
Is between Is on or after Ends with

Is not between Is after Does not end with

To interactively filter report data:

1. As you run the type of report shown in Figure 3-2, click the column you want to use for filtering the
report. Continuing with the example in “Running or Creating a Simple Report” on page 52, click the
Phone column in the Accounts report.

2. Click the v .

The Filter column dialog appears, as shown in Figure 3-6. By default, Show all rows is selected.

3. To build your filter, click the radio button to select Show only rows where.
the comparison operator drop-down and value entry box become active.

4. Select a comparison operator from the drop-down. For example, select Starts with to compare phone
numbers starting with certain numbers.

5. Enter a value for comparison with the data in the column. For example, enter the area code: 408-

b 4
Filter

Phone  Starts with ~ 408-

Figure 3-6 Filter Column Dialog

6.

Click OK.

The view of the report changes to show the filtered output. For example, now the Accounts Report only
shows accounts in the 408 area code.

05. Accounts Report Data refreshed May 19, 2014 =t 3:55:22 PM | £4

- 4 100% - L~ 4P Back H. B, + )] ]
Accounts 05/15/14 £/ I AsPERSOFT
# MNarme Phore 7 Addre=

1 Colme, US4

1 HE®EVanAmwerp Machinery com

3 9408-555-3003 A137 E St

2 la Me=, LEA

1 66 NEmmercommuniations Gmup £ 408-555-5009 660 5 Adria Drive

3 Marymille, LEA

1 R E 2 Gillat communicatiors, In [ 9058-555-4501 177 Eamcmdt road

4 Falo Alto, LEA

1 Mullim-Maes comtrxction Fartners £ 902-555-5001 8722 East View Plce

Figure 3-7 Filtered Report Shows Only Accounts in Area Code 408
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3.3.4

3.3.5

3.3.6

7.

A small star icon appears in the heading of the filtered column, to the right of the heading text.

To clear the filter indicator and once again display all the accounts, reopen the Filter column dialog and
select Show all rows, then click OK.

Interactively Sorting a Report

You can also sort data in report output interactively. For example, you can sort the data alphabetically in
ascending or descending order within each city listed in the Accounts Report.

To interactively sort report output:

1.

As you run the type of report shown in Figure 3-2, click the column you want to use for sorting the report.
For example, click the Name column in the Accounts report.

Click + (sort ascending) or ¥ (sort descending). The report refreshes, and data appears sorted by the

selected column in the selected order. In this example, for instance, if you select * , the grouped rows of
data are sorted alphabetically in ascending order within each group. Row 1 of the Bumaby, Canada group
isnow D & Z McLaughlin Electronics, Ltd and row 1 of the Cliffside, Canada group is Abbott-Liff
Electronics Holdings.

The heading text in the column used to sort report data appears red, and the up or down arrow icon in the
column header indicates that report output now appears in ascending or descending order, respectively.

To change the sort order of the groups themselves, you have to modify the report query.

Moving, Resizing, and Hiding Columns

Columns are easily moved, resized, and hidden in your report.

To move a column, click the column you want to move, then drag the column left or right into the new

v

position. The indicates where the column is placed.

To resize a column, click the column you want to resize, then drag the v until the column is the size
you want.

To hide a column, click the column you want to hide, then move your mouse over the - and select
Hide column.

Setting Output Scale

You can determine the display size for any report by using the report scaling options, located in the Report
Viewer tool bar.

Click F to zoom in on the report.
Click == to zoom out on the report.

Click 100% ¥ to open the Zoom Options drop-down menu, and select the percentage by which you

want to increase or decrease the size of the displayed report.
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3.3.7 Using the Bookmarks Panel

When working with a report that contains bookmarks, they are displayed in a floating panel. Using this panel,
you can jump to designated sections of the report.

Bookmarks X
Beverly Hills &
Bremerton
Burbank
Burien
Burlingame
Chula Vista
Colma
Concord
Coronado
Corvallis

Daly City

m

Crowney
Edronds
El Cajon
Everett
Fremont
Glendale
Grossmont
Imperial Beach
Issaquah
Kirkland
La Jolla

Lake Oswein

Figure 3-8 The Bookmarks Panel

*  To jump to a bookmarked section of the report, click the name of the section in the Bookmarks panel.

»  To display the Bookmarks panel, click in the Report Viewer tool bar.

3.4 Navigating the Report
If your report has multiple pages, you can use the pagination controls to move through the report quickly.
To navigate the published report:

* Use < at the top of the Report Viewer to navigate to the previous page.
* Use > to navigate to the next page.
. Use P 1o go to the end of the report.

*+  Use « to go to the beginning of the report.
* Ifyou know the number of the page you want to view, enter the page number in the Current Page indicator
box.
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3.5

Exporting the Report

To export the report:
1. To view and save the report in other formats, click the Export button.

2. Select an export format from the drop-down. The export options are listed in Table 3-6.

Table 3-6 Export File Types

Option Format Name Usage

PDF Adobe Acrobat Choose a report template based on report size. Use the
Actual Size report template for reports with dimensions less
than or equal to 14400px by 14400px. See 3.2.3, “Report
Templates,” on page 54 for more information.

Excel (Paginated) | XLS Not recommended for exporting most tables or crosstabs.
Repeats headers and footers on each page.

Excel XLS Ignores page size and produces spreadsheet-like output.

Ccsv Comma Separated Values Characters outside the Latin 1 character set can cause the
Excel spreadsheet to look unacceptable. Try saving the file
and importing it using Excel's Import functionality.

DOCX Word Do not export reports having more than 63 columns. In
Microsoft Word, you cannot create tables having more than
63 columns.

RTF Rich Text Format Creates a large output file and, therefore, takes longer to
export than PDF, for example.

OoDT OpenDocument Text For best results, minimize the number of rows and columns
and make sure they don’t overlap.

ODS OpenDocument Same as ODT.

Spreadsheet

XLSX (Paginated)

Microsoft Open XML Format
Spreadsheet

Not recommended for exporting most tables or crosstabs.
Repeats headers and footers on each page.

Presentation

XLSX Microsoft Open XML Format | Ignores page size and produces spreadsheet-like output.
Spreadsheet
PPTX Microsoft PowerPoint Each page of report becomes a slide in the PowerPoint

presentation.

3. Save the report in the export file format, for example PDF, or open the report in the application.
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3.6

Running a Flash Chart

The JasperReports Server commercial editions support Flash charting, and include the Maps Pro, Charts Pro, and
Widgets Pro component libraries.

Using the libraries, you can create visually appealing, animated, and interactive reports:

*  Maps Pro — Color-coded maps covering all countries and regions of the globe.

*  Charts Pro — Standard and stacked charts with animation and interactivity.

*  Widgets Pro — Non-standard charts such as gauges, funnels, spark lines, and Gantt charts.

These components are based on Fusion libraries and generate Flash output that is embedded in the HTML and

PDF output. When a report containing a Maps, Charts, or Widgets Pro element is exported in a format other
than HTML or PDF, the space used by the element remains blank.

To view a Maps, Charts, or Widgets Pro element in the server, install Flash Player. You might need to install
plug-ins or enable Flash on the browser. To view Flash elements in PDF output, use a Flash-enabled PDF viewer
such as Adobe Reader.

You can configure the server to default to HTMLS when rendering Pro Charts. See the JasperReports Server
Administrator Guide for more information.

Flash charts are created in Jaspersoft Studio Professional as JRXML reports and uploaded to the repository as a
report unit. JasperReports Server cannot create Flash charts. The sample report 14. Performance Summary
includes flash elements.

To find and run a Flash chart example:
1. In the repository, locate the sample report 14. Performance Summary.
2. Click the report name to run the report, which launches as part of the Performance Summary Dashboard.

14. Performance Summary  Data refreshed May 6, 2015 at 2:00:28 PM €3

sk H., B, B - 4 100% v Qi+ 4)
2. Performance Summary Dashhoard
- Profit Average Sale P Grawth Customers
[ ) { ] 0
"/ 646,582 138 © 90.9% 7,824
TOPS ACTUAL VS, PLAN DEMOGRAPHICS
Custormers Salles Trend %~
,  MarFans S— . 5C
eanigar v
: ¢
2 wioncameron T s9s0 F
W en ]
—_
r— s Woucin  Guerero p—
o e Tl
alisce I
4 Bmesmonat S— s926
5 KistinMilr N s87a M Male W Female
Geographies Sales Performance Average Sale
—
1 wa i267,606 °°' oo'
300k 80k w0 ————
2 20k
2 ca $154513 ] »
w 200k 60k _ 10k
3 zacawcas $150243 = 2 8
' 100k 40k Ok
—_—
4 OR $128,598
ok 20k -10k
———
s e s B feb Mar Apr May Jun Jul Aug Sep Oct Nov Dex sk

Figure 3-9 Performance Summary Dashboard with Flash Map
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3.7

3.7.1

Note the Sales Trend map in the center of the dashboard.

3. To interact with the map, mouse-over any of the countries to see the full country name and, when data
exists, the value for that country.

4. On the Sales Trend map, click Canada to launch the Interactive Sales Report, displaying the information
for Canada only. From there, you can modify the underlying report as needed.

To upload JRXML reports, see “Adding Reports Directly to the Repository” on page 157.

Running a Report with Input Controls or Filters

The server filters the data in the report output when you run a report with an input control. The perfect input
control limits the data to what you want to see—and nothing more. When you run a report based on a Domain
Topic that defines a filter, the server can render the filter as an input control.

If your system administrator has enabled the data snapshot feature (described in “Data Snapshots” on page 52),
it is important to note that the default input controls - that is, the input controls as defined when the original
Jaspersoft Studio- or Ad Hoc View-based report is run - will overwrite any changes made to them the next time
you run a report. For instance, suppose you run a report, update the input controls, then save the report. At a
later date, you run a report from the Jaspersoft Studio or Ad Hoc View source again. That new report will
replace the report you ran earlier, and your input control changes will be lost.

To avoid this, save your updated report with a different name than the default. That way, when subsequent
reports are run from the same source, they will not overwrite your report (unless they are given an identical
name when saved).

Simple Input Controls

The 16. Interactive Sales Report example has three input controls:

*  Country
* Request Date
*  Order ID

Using input controls, you run the report with one set of data and then another. When saved, an instance of the
report with alternate input controls is called a Report Version, and is labeled as such in the repository.

To run a report with simple input controls:
1. In the repository, locate and run the report 16. Interactive Sales Report.
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16. Interactive Sales Report  Data refreshed Oct 15, 2013 at 1:50:38 PM £
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Figure 310 |nteractive Sales Report

2. In the Filters panel, use the Country menu to select USA only.

* Country

|
Canada

Mexico

Al Mone  Inverse Close

*Randar

Figure 311 |nput Control Selection - Country

3. Click Close, then click Apply at the bottom of the panel. The report shows data for the USA only.

4. Click H- , then select Save As. You are prompted to name the new report.

5. Enter a new name, then click Save.

3.7.2  Multi-select Input Controls

The 1. Geographic Results by Segment Report has an example of a multi-select input control for Yearly Income.

To run a report with a multi-select input control:
1. In the repository, locate and run the report 1. Geographic Results by Segment Report.
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01. Geographic Results by Segment Report  Data refreshed Apr 30, 2015 at 4:12:44 P 44
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Figure 3-12 Geographic Results by Segment Report

On the tool bar, click E .
Scroll to the bottom of the Input Controls dialog to view the Product Name input control.
Enter chicken in the Search list .

Only products containing "chicken" are shown.

Click the first item in the list, then scroll down and Shift-click to select all the items with "chicken".
Click in the Search list again and delete the word chicken.

All items are displayed, with ones that include "chicken" selected.

Click the Selected tab to see that only items that are selected are displayed. Then click the Available tab
to view all the items.

Click Invert F£ to invert the selection.

Now all items are selected except those items that contain "chicken".

Click OK at the bottom of the panel. The report shows data for products that do not contain the word
"chicken" only.
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Input Controls

[# true -
|« false

All None Inverse

Product Name

Available: 1,560 Selected: 1,510
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ADJ Rosy Sunglasses
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Akron City Map

Akron Eyeglass Screwdriver

American Beef Bologna

American Chicken Hot Dogs
American Cole Slaw
American Corned Beef
American Foot-Long Hot Dogs
American Low Fat Bologna

American Low Fat Cole Slaw

« Select all ¥ Deselect All E Invert

4]

m DK Reset Cancel Save
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Figure 3-13 Multi-input Control Selection

3.7.3 Cascading Input Controls

Cascading input controls in a report reduce a large number of choices to a manageable number. A single value
chosen for a cascading input control determines which other values appear as choices for input. For example, the
choice of a country determines which states or regions are listed as choices. For more information, see
“Selecting a Data Source for Running the Complex Report” on page 180.

To run a report with cascading input controls:

1. In the repository, locate and run the report 16. Interactive Sales Report.
The report runs, and appears with the Filters panel open on the left side of the Report Viewer

2. In the Filters panel’s Country multi select drop-down, select a different country, for example Canada.
The other drop-downs in the Filters panel are automatically updated with Canadian data.

5( Cascading input controls are implemented as queries that access the database to retrieve the new
values. The server displays an activity monitor while the query is running, and in the case oflong
queries, you can click Cancel and select different values.

3. In the Product Name section, select a product to display in the report.
Click Apply to run the report with the chosen values.
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As with simple input controls, you can save these Options settings as a new Report Version. Click H- , then
select Save As.

3.8 Running a Report Book

Report books are multiple reports bundled into a single object, created in Jaspersoft Studio. You can run and
view report books from the Library page or the repository, much like you would a standard report. However,
report books contain some elements that are not found in standard reports.

To run a report book in the Report Viewer:

1. In the repository, click the name of the report book you want to run. For example, click the sample 17.
Report Workbook. The report appears, as shown below.

17. Report Workbook Dats refreshed Mow 24, 2014 at 8:58:59 aM  £4 TocReport Chart Crosstab Table <4 »

Page |1 of 20 B pp - 4 100% |+ O~ 4p Back H. E.

Table of Contents

Distribution by Country 4

Cliffside 12
Haney 14
Ladner 17
Langford 20
Langley 23
Metchosin 25
Mewton 20
M. Wancouver an
Oak Bay a3
Port Hammeond a5
Richrnond a0
Reyal Dak 41
Shawnee 43
Sooke 46
Wancouwver 49
“ictoria 51
Westminster 54
2. Mexico 56
12T T 57
Camacho 50
Guadalajara 52
Hidalge 55
La Cruz 57
Merids 70
Mexico City 72
Orizaba 75
San Andres 77 -

Figure 3-14 Sample report book as seen in the Report Viewer.

The sample report book contains three bundled reports:
+ Distribution by Country, a chart-type report.
* Customer Education, a crosstab-type report.
» Customers List, a table-type report.
Each of these reports can be accessed by a tab, along with the Table of Contents page, located at the top of
the Report Viewer.
2. Click the Chart tab to open the Customer Distribution by Country report. Note that you can interact
with this report as you would with a standard chart-based report in the viewer.

3. Click the TocReport tab to return to the table of contents page.
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3.9

3.9.1

4. Scroll down and click the Acapulco entry in the table of contents. The first page of the Acapulco table
entries is displayed.
Click o
6. Click the Customer Education entry in the bookmarks pane. The Customer Education crosstab report
opens in the viewer.

to open the bookmarks pane.

7. Close the bookmarks pane by clicking the x in the upper right corner of the pane.

Scheduling Reports

Using the report scheduler, you set up a schedule with report parameters, output options, and notifications:

*  Schedule — When to run the scheduled report, and how often

*  Parameters — If the report was designed with input controls, which parameters the scheduled report will use

*  Output Options — The name of the output file, the output format and locale, and where the output file is
stored

* Notifications — Email options for sending the report output to recipients and for sending administrative
messages

Scheduled reports run in the background to reduce the performance impact on the server. You can view a list of
scheduled reports on the View > Schedules page.

The permissions of the user who schedules a job determine the data that the report exposes. For example, Gloria
only has access to inventory data from the Southeast US region. A report that she schedules only shows data
from that region, even when the report is viewed by users in other regions. Other users schedule the report
themselves to see the data for their own regions.

Sensitive data could be exposed to unauthorized users if you schedule a job as an administrative user
with no data restrictions because the report will contain all requested data in the data source. Any user
who receives the report can view all the data regardless of the user’s access restrictions.

Creating a Schedule

To create a schedule:
1. Locate the report you want to schedule in the repository.
2. Right-click the report and select Schedule... from the context menu, or if the report already has a schedule,

click the schedule icon . The Scheduled Jobs page appears.

Scheduled Jobs: /public/Samples/Reports/04._Product_Results_by_Store_Type_Report

Back Create Schedule Run Now Refresh List

Job ID Job Name Oowner State Last Ran Next Run Enabled

Figure 3-15 Scheduled Jobs Page

3. Click Create Schedule. The Schedule tab of the scheduler appears.
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New Schedule

Schedule Parameters Output Options Notifications

Schedule For: /public/Samples/Reports/4_Product_Results_by_Store_Type Report

Schedule Start
Start Date:
& Immediately

' On Specific Date:

Time Zone:
America/Los_Angeles - Pacific Standard Time j

Recurrence:

Recurrence Type:

None b

Bl -

Figure 3-16 New Schedule Tab

4. Set a start date, choosing whether to run immediately or on a specific date. If a specific date is selected,
click the calendar icon to select a start date and time.

5. Specify the time zone for the schedule. The default time zone is the time zone of the server, the time zone
you entered at log in. If you’re in a different time zone, set this field accordingly.

6. Choose a recurrence setting, as described in “Running a Job Repeatedly” on page 78. If you select Simple
or Calendar Recurrence, additional controls appear on the page.
* None: Run the report once.
» Simple: Schedule the job to recur at a regular interval, specified in minutes, hours, days, or weeks.
+ Calendar: Schedule the job to recur on days of the week, days of the month, specific dates, or date

ranges.

@ If you set up a job with simple recurrence to startimmediately, the job schedule will change after
export/import or a server restart. This happens because the job does not retain the previous run
history and therefore starts immediately after import or restart. If you have a lot of scheduled reports,
all scheduled reports with simple recurrence will attempt to start at the same time after export/import
or restart. This can impact server performance. In addition, some scheduled reports may be locked
out and they will continue to try to run.

To ensure a recurring schedule does not change after export/import or restart, either use simple
recurrence with a specific start time, or set up calendar recurrence.

7. If the report you are scheduling has input controls that prompt for user input, click the Parameters tab.
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3.9.2

New Schedule

Schedule Parameters Output Options Notifications
Schedule For: /public/Samples/Reports/4_Product_Results_by_Store_Type_Report
--None-- ¥ Save Current Values

Country

Canada *
Mexico *
UsA =

[

Figure 3-17 Set the Parameter Values Page for Scheduling a Report

10.
11.
12.

13.

Saved values, if there are any, appear in a drop-down list at the top of the page, as shown in Figure 3-17. In
the Use saved values drop-down, you can set the input controls defined for the report you’re scheduling.
You can set the input values for the scheduled report, and click Save Current Values to save the input
value as a named set of values.

For more information about using saved values and saving input values, see “Running a Report with Input
Controls or Filters” on page 65.

Choose a set of saved values, or set the input controls.

Click the Output Options tab and set the output format and location, as described in Setting Output
Options.

Click the Notifications tab and set up email notifications, as described in Setting Up Notifications

Click Save. The Save As dialog box appears.

In the Scheduled Job Name field, enter a name for the job, for example, Weekly Report. The description
is optional.

Click Save to save the schedule. The job appears in the list of saved jobs for this report.

Setting Output Options

On the Output Options tab, you can change these settings:

File name — The base name for the output file in the repository. This name must be unique; if you attempt
to create a schedule with the same file name as an existing schedule, you will not be able to save.
Description — The optional description of the file that appears to users who view the repository.

Time Zone- The output time zone for generating the report.

Output Locale — The locale settings for generating the report.

The report must support locales, for example a report based on a Domain with language bundles (see
“Security and Locale Information for a Domain” on page 268).

Formats — The available output formats. Select one or more formats; the default format is PDF. When you
select more than one, each format is stored as a separate file in the selected output destination.
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* File Handling — Select one or more checkboxes to specify handling for multiple output files with the same
name:

*  Overwrite Files — Overwrites old output files with newer ones of the same name.

+ Sequential File Names by Timestamp — Appends a timestamp to the names of files created by the
job. Useful for the output of recurring jobs or for time-sensitive reports where the output must be dated.
When the timestamp is used, the output filename is <basename>-<timestamp>.<extension>. Note
that, depending on the frequency of the schedule and the format of the timestamp, it may be possible to
have two output files with the same name; in this case, modify the timestamp or use the Overwrite
Files checkbox to specify the behavior you want.

* Timestamp Pattern — When Sequential File Names by Timestamp is selected, a required pattern
for the timestamp, based on the java.text.SimpleDateFormat is required. Valid patterns for report
output files can contain only letters, numbers, dashes, underscores, and periods. The default pattern is
yyyyMMddHHmm, for example 200906150601.

*  For more information about the valid patterns for this field, refer to:
http://download.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.html

New Schedule

Schedule Parameters Output Options Motifications

Schedule For: /public/Samples/Reports/04._Product_Results_by_Store_Type_Report

Dutput File Options

File name {required):
04._Product_Results_by_Store_Type_Report

Drescription:

Tirme Zone:

America/Los_Angeles - Pacific Standard Time ¥

Cutput Locale:
{Default) v

Forrnats:

(el HTML RTF
DOCX oDs XLSX
Excel oDT wLE (Paginated)
Excel (Paginated) # PDF PPTH

File Handling:

# Overwrite Files
Sequential File Names by Timestamp

Timestamp Pattern:

Figure 3-18 Output Page for Scheduling a Report — Output File Options

*  Output Destination — To save the output file, select one or more checkboxes to specify the output
location. If you do not want to save the report output (for example, if you only want to email the report)
leave all checkboxes blank.

+ Output To Repository — If checked, saves the report output to the specified location in the repository.
You must have write permission to the output folder.
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*  Output To Host File System — If checked, saves the report output to the specified folder on the
Server host machine; check with your administrator for the correct location to enter. Output To Host
File System must be configured by an administrator; if the check box is grayed out, saving to the host
file system has not been enabled for your system. See the JasperReports Server Administrator Guide for
more information

*  Output To FTP Server — If checked, saves the report output to the specified FTP server. You must
have write permission to the selected directory on the FTP server. Enter the following properties of your
FTP server:

Output Destination

-

Server Address — The host, IP address or URL of the FTP server.

Directory — The directory on the FTP server where the report output is saved.

Username — The username for access to the FTP server.

Password — The password for the username.

Enable FTPS - If checked, specifies that server uses the FTPS file transfer protocol.

Port — Specifies the FTP connection port. For FTP, the default port is 21; for FTPS, the default port
is 990.

¥ output To Repository

/public/Samples/Reports

Browse

| Output To Host File System

[ Qutput To FTP Server [T Enable FTPS

Server Address Port

Directory

Username

Password

Figure 3-19 Output Page for Scheduling a Report — Output Destination

When you click Submit, the job appears in the list of scheduled jobs.

3.9.3 Setting Up Notifications

On the Notifications page, you can set up email notifications to the report recipients and to administrators.

tiﬁcations are sent to all users with the organization ROLE_ADMINISTRATOR role, who belong to the same
grganization as the user who creates the report job.
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Send report when scheduler runs:

Enter one or more email addresses to send the report to recipients after the job has run. You can configure the
following:

* To — One or more email addresses separated by commas for sending email notification.

z, By default, the mail server is not configured by the JasperReports Server installer. To send email
notifications, the administrator must configure the mail server, as described in the JasperReports
Server Installation Guide.

¢ CC - One or more email addresses separated by commas for sending email notification on the CC line.

*+ BCC - One or more email addresses separated by commas for sending blind carbon-copy email
notification; the addresses in this field are not revealed to the other recipients.

*  Subject — The subject line of the notification email.

* Message — Content of the notification email.

*  Choose one of the radio buttons to specify how email recipients access the report:

* Include reports as repository links in email body — Sends a link to the report output in the
repository. Not available unless Output to Repository is selected on the Output Options tab.

* Include report files as attachments — Sends the report output as attachments to the notification
email. If you have selected multiple output formats, each output is attached as a separate file to the
email notification.

* Include report files as ZIP attachment — Zips all report outputs into a single archive file before
attaching to the email.

* Include HTML report in email body — Displays the report directly in the email body. This option is
available only when Include report files as attachments or Include report files as ZIP
attachment is checked and HTML is selected as one of the options on the Output File Options page.
When this option is selected, you cannot include a message in the email body.

z, Be careful when sending reports containing sensitive data by email, either in the email body or as an
attachment.

* Do not send emails for empty reports — A check box option that, if checked, prevents the server from
attaching empty report output files to email notifications. This applies to parametrized reports where there is
no data that matches the parameters.

Send job status notifications:

Enter one or more email addresses to send notification of job success or failure to administrators:

* To — One or more email addresses separated by commas for sending email notification.

z, By default, the mail server is not configured by the JasperReports Server installer. To send email
notifications, the administrator must configure the mail server, as described in the JasperReports
Server Installation Guide.

*  Subject — The subject line of the notification email.

+ Send success notification — Check box option that, when checked, sends a notification when the
scheduled report runs.
* Success Message — The message in the body of the notification email sent on success.
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+ Send failure notification — Check box option that, when checked, sends a notification when the

scheduled report fails to run.

* Failure Message — The message in the body of the notification email sent on failure.

* Include report job information — A check box option that, if selected, includes the report label, ID,
description, and report job status in the notification email.

* Include stack trace — A check box option that, if selected, includes the stack trace for failed jobs in the

body of the email.

New Schedule

Email Notification

Send report when scheduler runs

Schedule For: /public/Samples/Reports/4_Product_Results_by_Store_Type_Report

Schedule Parameters Output Options Notifications

Send job status notifications

Tao: To:

CC: Subject:

e [T send success notification
Success Message:

Subject:

Message:

@ Include reports as repository links in email body
€ Include report files as attachments

€ Include report files as ZIP attachment

[T Include HTML report in email body

™ Do not send emails for empty reports

Bl

[T send failure notification

Failure Message:

I Include report job information

[T Include stack trace

Figure 3-20 Notifications Page for Scheduling a Report

3.9.4 Viewing the List of Scheduled Jobs

View a list of all scheduled jobs:

All scheduled jobs that the user has defined appear on the Click View > Schedules page.

Schedules

Resource Job Name

01. Geographic Results by Segmenl Weekly Report
/public/Samples/Reports/01._Geoagr...

01. Geographic Results by Segmenl Daily Report

/public/Samples/Reports/01._Geoagr...

Figure 3-21 The Scheduled Jobs Page for a Report

State Last Ran Mext Run Enabled
jasperadmin NORMAL 10/26/2015 11/2/2015 0 e 2 0
jasperadmin NORMAL 10/26/2015 10/27/2015 e 2 0
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Typical users see only the jobs they have defined; administrators see the jobs defined by all users. In Figure 3-
21, jasperadmin has scheduled two jobs for the Geographic Results by Segment report.

You can use the Schedules page's search field to find the scheduled job you want.

The Schedules page shows the name of the scheduled report, the repository URI of the report, the internal ID

number of the job, the user (owner) who created the job, and the state of the job. Job states are:

*  NORMAL - The job is scheduled.

«  EXECUTING - The server is generating the report output.

*+  COMPLETE - The server has finished running the job and placed output to the repository.

*  PAUSED- The job has been disabled. Click Enabled to resume the schedule.

* ERROR - The scheduler encountered an error while scheduling or triggering the job. This doesn’t include
cases where the job is successfully triggered, but an error occurs while it runs.

*  UNKNOWN - The scheduler encountered an error with the job trigger.

The Schedules page includes these controls:

+ Enabled checkbox — When checked, the job will run at the scheduled times. When unchecked, the job is
paused.

. s Edits the schedule.

« %/ _ Deletes the scheduled job.

When the server receives a request to delete a job that is running, the server completes running the job
before deleting it.

View scheduled jobs for an individual report:

Scheduled jobs appear in the repository with a icon beside the report name. To view the list of scheduled

jobs for a report, locate a report in the repository, click on the = icon or right-click the report, and select
Schedule from the context menu. The Scheduled Jobs page appears for the report. The Scheduled Jobs display
information on the report that's similar to the Schedules page.

You can filter search results for scheduled reports in the repository using the following options: Any
schedule (scheduled and unscheduled reports), Scheduled, Scheduled by me, or Not scheduled. See
1.5.2, “Filtering Search Results,” on page 18 for more information.

Buttons on the Scheduled Jobs page include:

Button Description

Back Returns to the list of reports.

Schedule Job Opens the Schedule tab to define a new job.

Run Now Opens the scheduler and allows you to run the job immediately. See “Running a Job in
the Background” on page 81.

Refresh List Refreshes the list of jobs, for example to see if a job has finished running.
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3.9.5

3.9.6

3.9.7

3.9.8

Changing Schedules

If the start date for a schedule has not yet passed, you can edit the schedule. Once the start date for a schedule
has passed, create a new schedule rather than changing the start date.

To edit a schedule:
1. Click View > Schedules.

2. Click # in the row of the job you want to change.
3. Make the changes on the Schedule, Parameters, Output, and Notifications pages.
4. Click Save. The update occurs immediately.

Pausing a Job
To stop a job from running without deleting it, disable the job.

To pause a scheduled job:
1. Click View > Schedules.
2. In the row of the job you want to stop, make sure Enabled is unchecked.

To resume a paused job:
1. Click View > Schedules.

2. In the row of the job you want to resume, make sure Enabled is checked. When a stopped job is re-
enabled, it waits until the next scheduled time to run.

Deleting a Job

To delete a scheduled job:
1. Click View > Schedules.

2. In the row of the job you want to delete, click %/

Running a Job Repeatedly

To run reports automatically on a regular basis, select simple or calendar recurrence on the Schedule tab:

» Simple recurrence repeatedly runs the job at a regular interval set in minutes, hours, days, or weeks.
+ Calendar recurrence involves more settings: time of day, days of the week, or days of the month, and
months of the year.

In Figure 3-22 you can see an example of how to set simple recurrence.
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Daily Report

Schedule Parameters Output Options Notifications

Schedule For: /public/Samples/Reports/4_Product_Results_by_Store_Type_Report

Schedule Start
Start Date:
' Immediately
@ On Specific Date:
2013-09-30 23:00 B

Time Zone:

America/Los_Angeles - Pacific Standard Time j

Recurrence:
Recurrence Type:

Simple 'l

Repeat every (required):

1 I days j

Schedule End
End Date:

0 Run a set number of times
MNumber of runs:

7 Run until 3 specified date:

& Run indefinitely

Holidays

Calendar of dates to exclude:

I MNone j

Bl o

Figure 3-22 Simple Recurrence Settings

Simple recurrence options are:

* Repeat every — The interval between jobs, in minutes, hours, days, or weeks.

* Run a set number of times — Runs the specified number of times.

*  Run until a specified date — Runs until a calendar date is reached. Click the calendar icon, ", to
select the date.

* Run indefinitely — Runs at the specified times until you delete the job.

* Holidays — A holiday calendar specifies a list of days when the scheduled report will not run. To use a
holiday calendar, select it from the drop-down list. Only one holiday calendar can be selected at a time.
Holiday calendars are configured by an administrator; if no calendars are available in this list, this
option has not been configured for your system.

If your server recognizes Daylight Savings Time (DST), jobs scheduled using simple recurrence may
seem to occur one hour later (when DST ends) or one hour earlier (when DST begins). If you want
jobs to recur at the same time of day and respect DST adjustments, use calendar recurrence.

TIBCO Software Inc. 79



JasperReports Server User Guide

@ If you set up a job with simple recurrence to startimmediately, the job schedule will change after
exportiimport. This happens because the imported job does not retain the previous run history and
therefore starts immediately after successful import. To ensure a recurring schedule does not change

after export/import, either use simple recurrence with a specific start time, or set up calendar
recurrence.

In Figure 3-23 you'll see an example of calendar recurrence settings.

Daily Report

Schedule Parameters Output Options Notifications

Schedule For: /public/Samples/Reports/4_Product_Results_by_Store_Type_Report

Schedule Start
Start Date:
© Immediately

% On Specific Date:
2013-09-30 23:00 =

Time Zone:

America/Los_Angeles - Pacific Standard Time j

Recurrence:

Recurrence Type:

Calendar 'I

Months: Days: Times:

® Every Month ' Every Day Hours (required):

0 Selected Months: @ Selected Days: 23
Jan ;l Sun -
Feb
Mar
Apr
May
Jun
ul Sat =l
Aug
Sep ' Dates in Menth:

Oct
MNowv

Dec ;I

Schedule End

End Date:

Holidays

Calendar of dates to exclude:

MNone j

Figure 3-23 Calendar Recurrence Settings

Calendar recurrence options are:

*  Months — The months during which the report runs.
*  Every Month
*  Selected Months
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3.9.9

3.9.10

» Days — The days when the report runs.
* Every Day
*  Selected Days
* Dates in Months — Enter dates or date ranges separated by commas, for example: 1, 15.

* Times — The time of day in minutes and hours when the job should run. The hours use 24-hour format.
You can also enter multiple minutes or hours, and ranges, separated by commas. For example, entering
0,15,30,45 for the minutes, and 9-17 for the hours, runs the report every 15 minutes from 9:00 a.m. to
5:45 p.m. Enter an asterisk (*) to run the job every minute or every hour.

* End Date — Calendar recurrence runs until a calendar date is reached. Click ““ to select the date.

* Holidays — A holiday calendar specifies a list of days when the scheduled report will not run. To use a
holiday calendar, select it from the drop-down list. Only one holiday calendar can be selected at a time.
Holiday calendars are configured by an administrator; if no calendars are available in this list, this option
has not been configured for your system.

Administrators see the chapter on scheduling in the JasperReports Server Web Services Guide for more
information on configuring calendars.

Running a Job in the Background

Running a job in the background generates a report, potentially long-running, without interrupting your
workflow. You can keep working in the server as the job runs. When the job completes, you can export the
report directly to any format and save it in the repository. You can share a report with others by sending the
generated report by email.

Running a job in the background is equivalent to scheduling the report to run immediately without recurrence.

To run a job in the background:

1. On the Home page, click View Your Reports; or from any page, click View > Reports.

2. Use the search field or Filters to find the report you want to run.

3. Right-click the report and select Run in Background from the context menu.
The Output page appears as shown in Figure 3-18.

4. Set the output format and location, as described in Setting Output Options. By default, the report output is
saved in the repository.

5. (Optional) If the report you are running has input controls that prompt for user input, click the Parameters
tab. Choose a set of saved values, or set the ficlds one at a time.

6. (Optional) Click the Notifications tab and set up email notifications, as described in Setting Up
Notifications

7. Click Save. The report begins to run immediately.

Event Messages

When an event occurs (for example, a scheduled report returns errors), JasperReports Server sends the owner of
the report a notification message. You can browse these messages to troubleshoot report scheduling problems in
the server. For example, you can determine that a report fails because its data source configuration uses incorrect
credentials.
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A common cause of the error message indicating that the report failed to execute is an incorrectly
configured mail server. The mail server must be manually configured after installation in order for users to
send email notifications.

The Messages page displays the list of events logged for the current user.

To open the Messages page:

1. On any page, click View > Messages. The Messages page appears.

2. To view a message, click its name. The message opens in the Event Details page.

3. To activate the buttons on the Messages page, click in a blank area of the message row that you want to
manage. The buttons appear.

Messages: Al -
Mark as Read | Mark as Unread Delete

Subject Date Type Componant

The job failed to execute, Review its parameters Taday Error Report Scheduler

Figure 3-24 Message Management Buttons

4. Use the buttons on the Messages page to manage the list of messages.
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CHAPTER4  WORKING WITH THE AD HocC EDITOR

4.1

This section describes functionality that can be restricted by the software license for JasperReports Server.
If you don’t see some of the options described in this section, your license may prohibit you from using
them. To find out what you're licensed to use, or to upgrade your license, contact Jaspersoft.

The Ad Hoc Editor is the interactive designer for creating and editing an Ad Hoc view, where you can explore
and analyze data from your Topic, Domain, or OLAP data source. Ad Hoc views can also be used to create
content for reports.

This chapter discusses the Ad Hoc Editor and Ad Hoc views, and includes the following sections:

*  Overview of the Ad Hoc Editor

*  Working with Tables

*  Working with Charts

*  Working with Standard Crosstabs

*  Working with OLAP Connection-based Crosstabs

* Calculated Fields and Measures

*  Using Filters and Input Controls

*  Creating a View from a Domain

*  Working with Topics

After you create an Ad Hoc view, you - and other users with the proper permissions - can run the report, then

further refine the displayed information and personalize the look of the report in the report viewer. For more
information on that process, see “Running Reports and the Report Viewer” on page 49.

Overview of the Ad Hoc Editor

The Ad Hoc Editor supports the creation of views for various types of reports: tables, crosstabs, and charts. You
intuitively interact with the editor to create these views by simply dragging and dropping elements. You can
add and summarize fields, define groups, label and title the report, and format data for each field. You can also
use the editor to explore and analyze data interactively.

To open the Ad Hoc Editor:
1. Click Create > Ad Hoc View. This opens the Select Data dialog.
2. Choose your data source from the list and click OK.
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4.1.1

select Data

-l = fe)
| Al Accounts Report
f‘. Audit Archive Dormain
-.T_‘. Audit Domain
| BEETWEN Date
| BEETWEN Date
T BEETWEN Date END included
& BEETWEMN Date EMD included
T BEETWEN Date FROM and END inc
T BEETWEN Date FROM and END inc
| BEETWEN Date From included
T BEETWEN Date From included
| Cascading multi select topic
.fl Custorners Report

=l demo for adhoc h

Figure 4-1 List of Data Sources in the Select Data Dialog

The Ad Hoc Editor contains the following panels, from left to right:

« Data Source Selection, which contains the fields, dimensions, and measures available in the source
Domain, Topic, or OLAP connection.

* Ad Hoc View, the main view design panel.

e Filters, which defines a subset of data to retrieve from the data source.

We’ll discuss how to use these panels to create an Ad Hoc view later in this section.

Ad Hoc Sources: Topics, Domains, and OLAP Connections

The following repository objects provide a prepared connection to a data source for Ad Hoc view creation:

*  Topics, JRMXL files created externally and uploaded to JasperReports Server as a basis for Ad Hoc views.
*  Domains, virtual views of a data source that present the data in business terms, allow for localization, and
provide data-level security.

*  OLAP Connections, multi-dimensional views of data that allow users to analyze a large number of
aggregate data levels.

You can also open and edit an existing Ad Hoc view to create a new Ad Hoc view.

4.1.1.1 Topics

Generally, an administrator or Jaspersoft Studio user creates a Topic as a JRXML file. The JRXML topic is then
associated with a data source in the server. A Topic can also be created from a Domain in the server. Both types
of topics appear in the Select Data wizard when you create an Ad Hoc view.

Using a Topic as your source generates an empty view, which allows you to begin adding data to your view
right away, without choosing, pre-filtering, or changing display names of the data (all of which are required
steps when creating a Domain-based view).
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To begin designing a Topic-based view:
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click Fe and navigate to Ad Hoc Components > Topics.
Expand the Topics folder and select a topic.

4. Select the type of view you intend to create: table, chart, or crosstab. For an overview of view types, see
“Ad Hoc View Types” on page 86.

You can now begin working on your view in the Ad Hoc Editor.

4.1.1.2 Domains

Administrators create Domains that typically filter the data, create input controls, and manage the list of
available fields and measures. A Domain specifies tables in the database, join clauses, calculated fields, display
names, and default properties, all of which define items and sets of items for creating Ad Hoc views.

To begin designing a Domain-based view:
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click B and navigate to Domains.
Expand the Domains folder and select a domain.
4. Click Choose Data..., and click the options on the left of the window to perform the following tasks:

*  Click Fields to select fields of data to use in the view.
*  Click Pre-filters to create filters to limit the data available in the Ad Hoc Editor.
*  Click Display to change the fields’ display names.
* Click Save as Topic to save the customized topic for later use.
5. Select the type of view you want to create: table, chart, or crosstab. For an overview of view types, see “Ad
Hoc View Types” on page 86.

You can now begin working on your view in the Ad Hoc Editor.

4.1.1.3 OLAP Connections

Administrators create OLAP client connections that expose transactional data and define how the data can be
seen as a multidimensional cube. An OLAP connection can expose multiple cubes in a single OLAP
connection.

With OLAP connections, you can create chart and crosstab views only.

To begin designing an OLAP connection-based view:
1. Launch the Ad Hoc Editor by clicking Create > Ad Hoc View.

2. In the Select Data wizard, click & and navigate to Analysis Components > Analysis Connections
and select a sample project and a connection.

You can now begin working on your view in the Ad Hoc Editor.

For more information about OLAP-based view functionality, refer to the following sections:

*  “Working with OLAP Connection-based Crosstabs” on page 115
*  “Working with Topics” on page 151
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4.1.2

Ad Hoc View Types

The Ad Hoc Editor allows you to select from three view types:

e Tables, which are used to view values in the database and to summarize the values in columns.
*  Charts, which compare one or more measures across multiple sets of related fields.

*  Crosstabs, which aggregate data across multiple dimensions.

This section provides an overview of each view type. The design and content tasks for working with each type
of view are discussed in more detail in the following sections:

*  For more information on table views, see Working with Tables.

*  For more information on chart views, see “Working with Charts” on page 97.

*  For more information on crosstab views, see “Working with Standard Crosstabs” on page 112.

4.1.2.1 Tables

The architecture of a table view consists of columns, rows, and groups.

Columns in a table correspond to the columns in the data source. They are included by adding fields or
measures to the table in the Ad Hoc view.

Rows correspond to rows in the database. The information in each row depends on what columns are included
in the table.

Using groups, rows can be grouped by identical values in any field with intermediate summaries for each
grouped value. For example, a table view of product orders might contain columns to show the dates and
amounts of each order, and its rows might be grouped by city and product.

86

TIBCO Software Inc.



Chapter 4 Working with the Ad Hoc Editor

Date Placed Date Filled Payment Received
City A
Product 01
Date Date Amount
Date Date Amount
Product 01 totals: Count Sum
Product 02
Date Date Amount
Date Date Amount
Product 02 totals: Count Sum
Product 03
Date Date Amount
Date Date Amount
Product 03 totals: Count Sum
City A totals: Count Sum
City B
Product 01
Date Date Amount
Date Date Amount
Date Date Amount

For more information on working with tables, see “Working with Tables” on page 92.

4.1.2.2 Charts

Charts summarize data graphically. Types of charts include bar chart, line chart, and pie chart, among others.

With the exception of time series and scatter charts, each type of chart compares summarized values for a group.
For example, the Chart tab might show the data in a bar chart that compared the sum of Payments Received for
each of the products in each of the cities.
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Total Payments Received

Lo llm

City A

City B

City C

Product01 B Product02 M Product03

Time series and scatter charts use time intervals to group data.

For more information on working with charts, see “Working with Charts” on page 97.

4.1.2.3 Crosstabs

Crosstabs are more compact representations than tables; they show only aggregate values, rather than individual
database values. Columns and rows specify the dimensions for grouping; cells contain the summarized
measurements. For instance, the example above could be displayed in a crosstab with columns grouped by sales

manager and year.
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4.1.3

4.1.4

Tom Harriet Manager
Totals
2012 2013 Year Totals 2012 2013 Year Totals
City A Product 01 Payment Payment Payment Payment Payment Payment Payment
Received Received Received Received Received Received Received
Product 02 Payment Payment Payment Payment Payment Payment Payment
Received Received Received Received Received Received Received
Product 03 Payment Payment Payment Payment Payment Payment Payment
Received Received Received Received Received Received Received
Product Payment Payment Payment Payment Payment Payment Payment
Totals Received Received Received Received Received Received Received
City B Product 01 Payment Payment Payment Payment Payment Payment Payment
Received Received Received Received Received Received Received
City Totals Payment Payment Payment Payment Payment Payment Payment
Received Received Received Received Received Received Received

For more information on working with crosstabs, see “Working with Standard Crosstabs” on page 112.

OLAP connection-based crosstabs behave differently than those created from Topics or Domains. See “Working
with Topics” on page 151.

The Data Source Selection Panel

The Data Source Selection panel contains a list of available fields in the chosen Topic or Domain. If you are

using a Domain, fields may appear in nested sets. Use the arrow beside the set name to expand or collapse a set
of fields.

Available fields may be divided into two sections in the panel, Fields and Measures. You can use the search
field in each section to locate a specific field or measure.

To hide this panel, click the icon in the top left corner; this is helpful when arranging content in a large Ad
Hoc view. Click the same icon on the minimized panel to expand it.

For more information on working with fields, see “Using Fields in Tables ” on page 92, “Using Fields and
Measures in Charts” on page 97, and “Using Fields in Crosstabs” on page 112.

The Ad Hoc View Panel

The Ad Hoc View panel provides tools that allow you to control what data is included in a view, and how it is
organized.

Along the top of the panel, there is a tool bar and two drop-down menus.

The first drop-down menu allows you to reset the view type. Use this menu to select Table, Chart, or
Crosstab. You can change the view type in the Ad Hoc Editor during the design or when you reopen the
design for editing.

The next drop-down menu contains options for displaying a subset of the available data (Sample Data), all
available data (Full Data), or none of the available data (No Data) in the view. Using the sample data can
make the design process quicker by loading less data. Use the subset for initial design; use the full set for
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refining layout elements such as column width. This drop-down menu is not available for charts, which use all
available data.

By default, the editor displays only a smaller, sample set of the data in the table. Use the drop-down menu to
select Full Data to view the full set of data.

Depending on its configuration, JasperReports Server may load a Topic, Domain, or OLAP connection’s
entire result setinto memory when you edit the view, or run a report from it. If the data policies and other
options that control JasperReports Server’'s memory are disabled, ensure that each Topic, Domain, or
OLAP connection returns a manageable amount of data, given the environment's load capacity.
Alternately, you can change the server’s configuration.

The tool bar at the top of the panel provides access to many functions of the Ad Hoc Editor. The toolbar is
described in Table 4-1 on page 90.

Table 4-1 Ad Hoc Editor Tool Bar Icons

Icon Name Description
@ Display Click this icon to hide the editor interface. This mode provides a subset of the
Mode editor’s full feature set.
B Save Place the cursor over this icon to open a menu of save options.
B Export Place the cursor over this icon to open a menu of export options.
e, Undo Click this icon to undo the most recent action.
e Redo Click this icon to redo the most recently undone action.
£ Undo All Click this icon to revert the view to its state when you last saved.

Switch Group

Click this icon to change the way groups are displayed. For more information, refer
to “Creating a View from a Domain” on page 146.

1; Sort When working with tables, click this icon to view the current sorting and to select
fields for sorting data. For more information, refer to “Sorting Tables” on page 95
E Input Click this icon to see the input controls applied to this view. For more information,
Controls refer to “Using Input Controls” on page 143.
Page Place the cursor over this icon to open a menu of page-level options. You can:
Options + Change whether to display the Layout Band.

+ Change whether to display the title area.

* Intables, you can also hide or show the detail rows when the data is
summarized. This option is available only if the table includes grouped columns.

* In crosstabs, you can merge or unmerge cells with the same data.
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4.1.4.1

Icon Name Description
?é View For more information on viewing SQL queries, see “Viewing the SQL Query” on
SQL/MDX page 91
Query For more information viewing MDX queries, see “Viewing the MDX Query” on
page 117

The Layout Band
Directly beneath the tool bar is the Layout Band. Here there are two fields. These fields have different labels
and functions, depending on the type of view you are creating:

*  For tables, these ficlds are Columns and Groups.
e For charts, these fields are Columns and Rows.
*  For crosstabs, these fields are Columns and Rows.

You can drag and drop fields and measures into these boxes to populate your view.

4.1.4.2 Managing Canvas Options

When working with a table or chart view, the Canvas Options selector appears below the Layout Band, to the
left of the view title. This tool allows you to control the level of detail displayed in your table or chart. Click

" to display the options available for your Ad Hoc view type.

For tables, the Canvas Options selector includes the following options:
* Detailed Data displays table detail only.

+ Totals Data displays table totals only.

* Details and Totals displays both details and totals.

For charts, the Canvas Options selector includes the following options:

* Chart Types displays the available chart types.
* Chart Format displays formatting options.

4.1.4.3 Viewing the SQL Query

4.1.5

You may want to look at the SQL query for your view, to verify what data users are hitting. If you have the
proper permissions, you can do this in the Ad Hoc Editor with the View Query button.

The query is read-only, but can be copied onto a clipboard or other document for review.

To view the SQL query:

* In the tool bar, click =0

The View Query window opens, displaying the SQL query.

The Filters Panel

The Filters panel displays any filters defined for the view. You can set the filter values and see the resulting
change in the Ad Hoc View panel. To hide the Filters panel, click the icon in the top left corner of the panel.
Click the same icon on the minimized panel to expand it again.

For more information on working with filters, see “Using Filters and Input Controls” on page 139.
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4.1.6

Saving an Ad Hoc View, Previewing and Creating a Report

After you create a compelling table, chart, or crosstab, you can save the view in the repository for future use.
To save an Ad Hoc view:

1. Hover your mouse over = .
2. Select Save Ad Hoc View or Save Ad Hoc View As.

3. Name the view as needed, and click Save. The view is saved in the repository.

You can also save an Ad Hoc view as a report. Typically, a report is created when you want to:

* See data in the interactive report viewer.
*  Perform additional formatting of the table data.
*  Embed the data content in a dashboard.

Create a report from the view by selecting Save Ad Hoc View and Create Report; you can also create and
run a report directly from the repository. For more information, see “Running or Creating a Simple Report” on
page 52. When you run the report, it is displayed as a JasperReport.

4.1.6.1 Dependent Reports

4.2

4.2.1

When you create a report from an Ad Hoc view, the report is considered “dependent” on that view.

When you save an Ad Hoc view its dependent reports are not updated. For example, if you open an Ad Hoc
view in the Editor and add a column to it, that column will not show up in previous reports created from that
view. In such a case, you may want to save the updated view with a different file name to avoid confusion.

Working with Tables

The following sections explain how to populate, edit, and format your table-type view.

Using Fields in Tables

Insert data into your table by adding fields. All available fields are listed in the Data Source Selection panel,
on the left side of the Ad Hoc Editor.
The available fields are divided into two sections in the panel:

* Fields, which can be added to the table as columns or groups.
* Measures, which are specialized fields that contain data values.

To add fields and measures as columns to a table:

1. In the Data Source Selection panel, click to select the field or measure you want to add to the table. Use
Ctrl-click to select multiple items.

2. Drag the selected item into the Columns box in the Layout Band.
The field is added to the view as a column in the table.

To remove a field or measure from a table:

* In the Layout Band, click the X next to the field or measure’s name.

92

TIBCO Software Inc.



Chapter 4 Working with the Ad Hoc Editor

4.2.1.1 Groups

Groups allow you to create detailed data rows. For example, if you have a table that lists the suppliers for a
national restaurant chain, you can group the suppliers by the State field. The suppliers’ names are then
rearranged so that all suppliers located in Maine, for instance, are located under a “Maine” header row; suppliers
in Maryland are together under a “Maryland” header row, and so on.

You can use multiple fields to make more specific nested groups. By adding a group based on the “City” field
to the table described above, the restaurant suppliers are arranged by City within the State groups. Under the
“Maine” header row, new header rows for Augusta, Bangor, and Portland are added, and the names of the
Maine-based suppliers appear under their respective cities. Under the “Maryland” header row, header rows for
Annapolis, Baltimore, and Silver Spring are added, and the names of Maryland-based suppliers appear under
those headers, and so on.

Only fields can be applied to a table as a group; measures cannot.

Data is grouped in the table according to the order they have defined. You can change the order by dragging
the groups into position if needed.

To create a group:
1. In the Data Source Selection panel, click to select the field you want to add to the table as a group.
2. Drag the field to the Groups box in the Layout Band.

The Ad Hoc view refreshes and displays the data grouped under a new header row.

z/ You can also add a group to the table by right-clicking a field and selecting Add as Group.

To remove a group:
* In the Layout Band, click the x next to the field’s name in the Groups box.

To move a the grouping order up or down in a table:
* In the Layout Band, drag the name of the group you want to move into its new position.

4.2.1.2 Summaries

You can display summary data for any column in your table. Summary data may be in the form of various
functions, such as:

e Sum

*  Count

* Distinct Count

*  Average

For example, in a table with a list of stores, grouped by City and Country, you can display the number of stores
in each City, and in each Country, using this function.

By default, the summary function for each field is defined by the data source, OLAP, or domain definition.

To add a summary to a specific column:
* In the table, right-click the column you want to calculate a summary for, and select Add Summary.

The summary information is added to the group header, or is added to the bottom of a column if no groups
are included in the table.

TIBCO Software Inc. 93



JasperReports Server User Guide

To remove a summary from a specific column:

* In the table, right-click the column with the summary you want to remove, and select Remove Summary.
The summary information is removed from the table.

To add or remove summaries from all columns:

* Click aﬂ " and select Detailed Data.

4.2.1.3 Column and Header Labels

You can edit a column or header label directly in the Ad Hoc Editor.

To edit a column or header label:

1. On the Ad Hoc view panel, right-click the column or group header you want to rename.
2. Select Edit Label from the context menu. The Edit Label window opens.

3. In the text entry box, delete the existing name and enter the new name.

4. Click Submit.

If space is at a premium, you can remove labels from the view. When you delete a label, it still appears when
you look at the view in the Ad Hoc Editor, but does not appear when you run the report.

To delete a column or header label:
1. On the Ad Hoc view, right-click the column or header label you want to remove.
2. Select Delete Label from the context menu.

To re-apply a label:

1. Right-click the column or header label you want to replace.

2. Select Add Label from the context menu. The Edit Label window opens.
3. Enter the label name, if needed.

4. Click Submit.

4.2.1.4 Managing Column Size and Spacing

You can change the size of, and spaces between, columns to manage the appearance of your table or use space
more efficiently.

To resize a column:

1. In the Ad Hoc View panel, click to select the column you want to resize.

2. Move the cursor to the right edge of the column.

3. When the cursor changes to the resize icon (+*), click and drag the column edge right or left until the
column is the needed size.

Spacers can be added to a table to arrange columns farther apart, or add margins to a table.

To change the spacing between columns:
1. In the Data Source Selection panel, in the Measures section, click Spacer.

2. Drag the spacer into the Columns box in the Layout Band between names of the two columns you want
to move apart.

A spacer column, labeled * , appears in the table.
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3.
4.

Repeat this action to add space as needed between columns.

To remove a spacer, right-click the spacer column and select Remove from Table.

To use spacers to create table margins:

1.

2.
3.
4

In the Data Source Selection panel, click to select Spacer.
Drag the spacer into the Columns box in the Layout Band.
Repeat until the margins are as wide as needed.

Repeat the steps above, adding the spacer to the right edge of the table.

4.2.1.5 Reordering Columns

You can move columns to the right or left to reorder data in your table.

To reorder a column:

1.
2.

In the Ad Hoc View panel, right-click the column you want to move.
Select Move Right or Move Left from the context menu.

4.2.1.6 Sorting Tables

In the Ad Hoc Editor, you can sort the rows of a table by any field, using a number of different methods.

To sort a table:

6.
7.

A
Click 21 . The Sort window appears. If the table is already sorted, the window shows the fields used.

To add a field to sort on, double-click the field in Available Fields. The Available Fields panel now lists
only fields not currently in Sort On.

Select one or more fields to sort by. You can also use Ctrl-click to select multiple fields.

| 2
Click
To arrange the sorting precedence of the fields, select each field in the Sort window and click Move to top,

Fy FY v b4
Move up, Move down, or Move to bottom: , , , and

To remove a field, select it and click
Click OK. The table updates to display the rows sorted by the selected fields.

You can also sort a table using the following methods:

Right-click a field in the Fields section of the Data Source Selection panel, and select Use for Sorting
from the context menu. In this case, the table is sorted by a field that isn’t in the table; you may want to
note the sorting fields in the title.

Right-click a column header on the Canvas of the Ad Hoc View panel, and select Use for Sorting from
the context menu.

If a column is already being used and you want to stop using it or change the sorting, right-click the

column and select Change Sorting from the context menu.
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4.2.1.7 Adding a Title
1. Above the table, click the text Click to add a title.

2. Enter the new table title in the text entry box.

4.2.1.8 Changing the Data Format

You can change the formatting for columns containing numeric data, such as dates and monetary amounts.

To change the data format for a column:
1. In the Ad Hoc view, right-click the column.
2. Select Change Data Format from the context menu.

3. Select the format you want to use. These options vary, depending on the type of numeric data contained in
the column.

The data in the column now appears in the new format.

4.2.1.9 Changing the Data Source

You may need to select a new data source for your table. This is a simple task, but you should keep in mind
that all view data and formatting are lost when you select a new Topic, Domain, or OLAP connection. Any
changes to the view are also lost if you navigate to another page using the browser navigation buttons, the main
menu, or the Search field. To preserve changes, accept the current Topic or click Cancel.

To change the table’s data source:
1. At the top of the Data Source Selection panel, click B~ and select Change Source.
2. Select a different Topic, Domain, or OLAP connection.

3. Click Table to apply the new data source.

Click Cancel to return to the editor without changing the Topic.

4.2.1.10 Showing and Hiding Detail Rows

You can simplify or expand the information in your table by hiding or showing detail rows.

To hide detail rows in a table:

2. Select Hide Detail Rows to show only the summarized totals for each group.

1. Place the cursor over

The Ad Hoc Editor applies a summary to each field depending on its datatype.

To show detail rows in a table:

2. Select Show Detail Rows to display the detailed information for each group.

1. Place the cursor over

The Ad Hoc Editor displays the complete information in each row.

4.2.1.11 Controlling the Data Set

o,

You can control the data displayed in the grid using the Grid Detail Selector:

Your options are:
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4.3

4.3.1

* Detailed Data, which displays table detail only. For instance, in a table listing sales in dollars for all stores
in a region for a given month, the amount sold by each store that month is displayed.

* Totals Data, which displays the table totals only. In the table described above, the total amount of all sales
at all regional stores that month is displayed.

* Details and Totals, which displays both the individual store sales numbers, as well as the total sales
numbers at the bottom of the store sales column.
Click to select the option you want to apply to your table.

Working with Charts

Ad Hoc charts are a flexible, interactive way to explore your data graphically. You can choose different levels
of aggregation for rows and columns, change a field from a column to a row, pivot the entire chart, hide chart
values, and zoom in to see chart details.

The following sections explain how to populate, edit, and format an Ad Hoc chart. Many tasks related to
working with charts are identical (or very similar) to those for tables and crosstabs. For any tasks not discussed
in this section, see the information in “Working with Tables” on page 92.

Using Fields and Measures in Charts

You must add at least one measure to view a chart. Before any measures are added to the chart, the Ad Hoc
Editor displays a placeholder with the legend displaying a single entry: Add a measure to continue. As you add
measures, the editor displays the grand total of each measure in the chart.

The initial display reflects only the measures you add; it does not change when you add fields or dimensions.
For example, for each measure you add to a bar chart, you see a bar with the total value of the measure,
regardless of how many fields you add. This means you can add, remove, and arrange measures and fields
without waiting for the display to update. Once you have the fields and measures you want, you can use the
sliders on the right to select the level of detail you want. See Figure 4-2 for more information.

All available fields are listed in the Data Selection panel, as either standard fields or measures.

* Standard fields can be added to a column or a row.

*  Measures contain summarized values. They are typically numeric fields that determine the length of bars,
size of pie slices, location of points (in line charts), and height of areas. They can be added to rows or
columns, but must all be in the same target — that is, you can add one or more measures to the chart as
columns, or add one or more measures to the chart as rows, but you cannot have one measure as a column
and another as a row in the same chart.

When creating a chart, keep in mind that row and column groups are arranged in hierarchies, with the highest
member of the hierarchy on the left. For an Ad Hoc view based on an OLAP data source, you can change the
order of distinct dimensions by dragging, but you cannot change the order of levels within a dimension. For an
Ad Hoc view based on a non-OLAP data source, you can drag the field headings to rearrange the hierarchy; the
highest level in a group should appear to the left; the lowest level in a group should appear to the right. For
example, it doesn’t make sense to group first by postal code then by country, because each postal code belongs
to only one country.

To add a field or measure to a row or column:

1. In the Data Selection panel, select the field you want to add to the chart as a group. Use Ctrl-click to
select multiple items.

2. Drag the selected item into the Columns or Rows box in the Layout Band.

TIBCO Software Inc. 97



JasperReports Server User Guide

4.3.1.1 Setting Levels

When you add a field or dimension to a column or row, a multi-level slider located at the top of the Filters pane
allows you to set the level of aggregation to use for viewing the data. The number of fields or dimensions in the
row or column determines the number of levels on the slider. Measures are not reflected in the slider.

You cannot adjust levels on time series charts.

The following figure shows the effect of the slider on a chart with one level of aggregation for both rows and

columns.

1,000
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250K

300k
250k
200k
150k
100k

Rows
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J

Q11998

Columns

Totals

| 0 store sates

Q2 1998

" 1 Store Sales |

Figure 4-2 Effect of the Slider on a Chart

To recreate this view:

1. Select Create > Ad Hoc View.

Q31998

Q41998

800k

800K
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2. In the Select Data wizard, select foodmart data for crosstab and click OK.

3. Drag the following from the Fields panel to the Layout Band:

+  Store Sales from Measures to Columns. The view changes to show a column with the total. No slider

is added for measures.

*  Product Family from Fields to Columns. The Data Level area is shown in the Filters panel, with a
Columns slider added.

* Date from Fields to Rows. A Rows slider is added to the Data Level area in the Filters panel.

4. Use the sliders to see how the view changes.

The sliders help you explore your data visually in a number of ways:

*  The slider reflects the hierarchy of the row or column groups, as determined by the order in which fields are
arranged in the Layout Band.
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* Hovering over a setting on the slider shows the name of the field or dimension corresponding to that
setting.

*  When you pivot a chart, slider settings are preserved and applied to the new target. For example, if you
have the Row slider set to Month, the Column slider is set to Month when you pivot. See “Pivoting a
Chart” on page 99 for more information.

*  When you remove the currently selected level from a row or column, the slider is reset to the total; when
you remove a field that is not selected, the level remains the same. When you add a field or dimension to a
row or column, the number of levels of the slider changes to reflect your addition. When you change the
order of the fields in a row or column, the level on the slider changes to reflect the new level of the field
corresponding to the selection.

4.3.1.2 Changing Date Grouping

If your chart includes data based on a date field, you can change the level of aggregation for the time data. To
select the unit of time to chart:

*  Right-click on the date field in the Layout Band and select Change Grouping. Then select the time
period you want from the cascading submenu. The view updates to reflect the new date grouping.

Time Series charts can use only day, or smaller, intervals.

4.3.1.3 Changing the Summary Function of a Measure

You can get a new view of your data by changing the summary function of a measure, for example, from sum to
average. To select a new summary function for a measure:

*  Right-click on the measure in the Layout Band and select Change Summary Function. Then select the
function you want from the cascading submenu. The view updates to reflect the new summary function.

4.3.1.4 Pivoting a Chart

You can pivot a chart in two ways:

*  Pivot the entire chart by clicking IT’ . The row and column groups switch places; slider levels are
maintained. The following figure shows the effect of pivoting a basic column chart.
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Figure 4-3 Effect of Pivoting a Chart

Pivot a single group:

* To pivot a single row group, right-click it and select Switch To Column Group. You can also move
any field or dimension by dragging. You cannot drag a measure to a different group.

* To pivot a single column group, right-click it and select Switch To Row Group. You can also move
any field or dimension by dragging. You cannot drag a measure to a different group.

4.3.2 Selecting a Chart Type

Choose from multiple chart types to best represent your information, including:

Column, which compares values displayed as columns.

Bar, which compares values displayed as bars.

Line, which compares values displayed as points connected by lines.
Area, which compares values displayed as shaded areas.

Spider, which compares three or more values on a series of spokes. Spider charts can use columns, lines, or
areas to display values.

Dual- and Multi-Axis, which display values using two or more measures.

Time Series, which compares time intervals displayed as points connected by lines. The Time Series chart
type is only available for non-OLAP charts.

Scatter, which compares values as individual points arrayed across both axes of a chart.

Bubble, which compares three measures displayed as circles of varying sizes arrayed across both axes of a
chart.

Pie, which compares values displayed as slices of a circular graph.

Range, which displays values as heat and tree maps. Only the Heat Map chart is available for OLAP data
sources.

By default, the Ad Hoc Editor creates a column chart. You can select a different type of chart at any time.
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If you recently upgraded to JasperReports Server 5.5 or later you may find that existing scatter charts did
not update, and are incompatible with the newer software. You can use the Ad Hoc views for those scatter
charts to generate new reports, but you can't edit the views for scatter charts created in earlier versions of
JasperReports Server.

To select a new chart type:
1. Inthe Ad Hoc View panel, click the %~ icon to show the Canvas Options menu.
2. Select Chart Types... from the menu. The Select Chart Type window is displayed.
Select Chart Type »
Column and Bar
ath | bl = = = <
Line and Area
| L an o BB o Y &
Dual and Multi-Axis
it | il R (N S B |HHE
Time Series

Scatter and Bubhble

Pie
Range
i+ % Il . (]
Emmmm | | : e =

Figure 4-4 Select Chart Type Window

3. Click the type of chart you want to apply to your report. The selected chart type is outlined in blue.

4. Leave the Select Chart Type window open to rapidly switch between chart types, or click the *' icon at
the top right to close it.

The following table describes the available chart types, and rules (if any) affecting their use:
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Table 4-2 HTML5 Chart Types

Icon

Description

Rules

Column charts

Column charts compare values displayed as
columns.

Column. Multiple measures of a group are
depicted as individual columns.

Stacked Column. Multiple measures of a group
are depicted as portions of a single column
whose size reflects the aggregate value of the

group.

Percent Column. Multiple measures of a group
are depicted as portions of a single column of
fixed size.

Spider Column. Multiple measures of a group
are depicted as portions of individual "columns"
along a spoked chart.

Bar charts

Bar charts compare values displayed as
bars.

Bar. Multiple measures of a group are depicted
as individual bars.

Stacked Bar. Multiple measures of a group are
depicted as portions of a single bar whose size
reflects the aggregate value of the group.

Percent Bar. Multiple measures of a group are

depicted as portions of a single bar of fixed size.

Line charts

Line charts compare values displayed as
points connected by lines.

Line. Displays data points connected with
straightlines.

=X~

Spline. Displays data points connected with a
fitted curve.

Spider Line. Displays data points connected
with straightlines on a spoked chart.
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Icon

Description

Rules

Area charts

A~

Area. Displays data points connected with a
straight line and a color below the line; groups
are displayed as transparent overlays.

Stacked Area. Displays data points connected
with a straight line and a solid color below the
line; groups are displayed as solid areas
arranged vertically, one on top of another.

Percent Area. Displays data points connected
with a straightline and a solid color below the
line; groups are displayed as portions of an
area of fixed sized, and arranged vertically one
on top of the another.

Area Spline. Displays data points connected
with a fitted curve and a color below the line;
groups are displayed as transparent overlays.

Spider Area. Displays data points connected
with straight lines and a solid color between the
line and the center of a spoked chart; groups
are displayed as transparent overlays.

Dual- and Multi-Axis
charts

You can compare two or more measures,
using one charting time or multiple charting
types, with the charts listed here.

Column Line. Displays leftmost measures as
bars, last measure as a line.

* Requires two or more
measures.

* Measures must be placed in
the Columns location.

* Fields and dimensions can
be placed only in the Rows
location.

Stacked Column Line. Displays leftmost
measures as stacked bars, last measure as a
line.

* Requires three or more
measures.

* Measures must be placed in
the Columns location.

» Fields and dimensions can
be placed only in the Rows
location.
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Icon Description Rules

Column Spline. Displays leftmost measures as * Requires two or more

bars, last measure as a spline. measures.

* Measures must be placed in
the Columns location.

+ Fields and dimensions can
be placed only in the Rows

location.
HITH Stacked Column Spline. Displays leftmost * Requires three or more
measures as stacked bars, last measure as a measures.
line. * Measures must be placed in

the Columns location.

* Fields and dimensions can
be placed only in the Rows
location.

Z_M._a.': Multi-Axis Line. Displays each measure as a * Requires two or more
separate axis line. measures.
* Measures mustbe placed in
the Columns location.
+ Fields and dimensions can
be placed only in the Rows
location.

Multi-Axis Spline. Displays each measure as a * Requires two or more

separate axis spline. measures.

* Measures must be placed in
the Columns location.

+ Fields and dimensions can
be placed only in the Rows
location.

i Multi-Axis Column. Displays each measure as * Requires two or more

a separate axis column. measures.

* Measures must be placed in
the Columns location.

+ Fields and dimensions can
be placed only in the Rows
location.
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Icon

Description

Rules

Time Series charts

Time Series charts illustrate data points at
successive time intervals.

Line. Displays date and time data points

* Requires a single date/time

connected with straight lines. field in the Rows location.
+ Field mustbe setto the
"day" group function.
e Spline. Displays date and time data points * Requires a single date/time
connected with a fitted curve. field in the Rows location.
+ Field mustbe setto the
"day" group function.
- Area. Displays date and time data points * Requires a single date/time

connected with a straightline and a color below
the line; groups are displayed as transparent
overlays.

field in the Rows location.
* Field must be set to the
"day" group function.

=1

Area Spline. Displays date and time data points
connected with a fitted curve and a color below
the line; groups are displayed as transparent
overlays.

* Requires a single date/time
field in the Rows location.

* Field mustbe setto the
"day" group function.

Scatter charts

Scatter charts show the extent of correlation
between the values of observed quantities.

Scatter. Displays first measure as the x-axis,
the second measure as the y-axis. Other fields
and dimensions in the column group become
data points.

* Requires exactly two
measures.

* Measures must be placed in
the Columns location.

Bubble charts

Bubble charts show the correlation between
three measures, displayed as disks.

Bubble. Displays first measure as the x-axis, the
second measure as the y-axis, and the third
measure determines the size of the disk.

Pie charts

Pie charts display values as slices of a
circular graph.

Pie. Multiple measures of a group are displayed
as sectors of a circle.

Dual Pie. Multiple measures of a group are
displayed as sectors of concentric circles.
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[,

colors.

Icon Description Rules
L ngi-Pie. Multiple measures ofa group are

displayed as sectors of a half-circle.
Range charts Range charts display values heat maps.

Heat Map. Individual values represented as Non-OLAP:

One field, followed by one
Measure, required in the
Columns location.

One field required in the
rows location.

OLAP:

One Dimension level,
followed by one Measure,
required in the Columns
location.

One Dimension level
required in the Rows

of each rectangle is proportional to the measure
of the data it represents. The tree map displays
nested rectangles when you have more than
one field; the parent rectangle represents the
leftmost measure while the nested rectangles
represent the current level of aggregation. Click
on a parent rectangle to drill down to the nest
rectangles.

location.
. g Time Series Heat Map. Individual values * One Measure required in
e across dates/times represented as colors. the Columns location.

* One Date/Time field
required in the Rows
location.

* Only available for non-OLAP
data sources.

- Dual Measure Tree Map. Displays data as * Two Measures required in
color-coded rectangles; the size of each the Columns location.
rectangle is proportional to the first measure - One field required in the
and the color represents the second measure. .

Rows location.

* Only available for non-OLAP
data sources.

[ Tree Map. Displays data as rectangles; the size | - One Measure required in

the Columns location.

One or more fields required
in the Rows location.

Only available for non-OLAP
data sources.
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Icon Description Rules
] Parent Tree Map. Displays data as nested * One Measure required in
= rectangles; the size of each rectangle is the Columns location.

proportional to the measure of the data it
represents. The nested rectangles represent the
current level of aggregation while the larger
rectangle represents the parentlevel in the * Only available for non-OLAP
hierarchy. Click on a parent rectangle to drill data sources.

down to the nest rectangles.

* Two or more Fields required
in the Rows location.

4.3.3 Formatting Charts

You can control some aspects of how data points, field names and labels are displayed on your chart, including:
*  Whether data points are displayed.

*  Showing a measure name on charts including only a single measure.

*  Restricting the number of labels displayed.

* Rotating the direction of label text.

JasperReports Server also allows you to edit many of the chart's properties for cases when you want more
control over the appearance of a chart.

4.3.3.1 Displaying Data Points

You can choose whether to display data points in your line, time series, or area chart. Data points can help users
visualize chart data more accurately.

To show data points on a chart:

1. Inthe Ad Hoc View panel, click the %~ icon to show the Canvas Options menu.
2. Select Chart Format... from the menu. The Chart Format window is displayed.
3. Click the Appearance tab and select Show data points on line charts.

4. Click Apply, then OK. The name appears along the value axis.
5

To remove data points from the chart, open the Appearance tab and deselect Show data points on line
charts.
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Figure 4-5 Chart Format Window

4.3.3.2 Displaying the Measure Name on the Value Axis

By default, in charts that include only a single measure, that measure's name is not displayed. For instance, if
your measure displays the number of employees for each store in the region, that measure's label appears along
the Y- (or value) axis, but the name of the measure ("Number of Employees" or similar) does not. You can,
however, choose to display that measure name to clarify the information on your chart.

To show a measure name on the value axis:

In the Ad Hoc View panel, click the %~ icon to show the Canvas Options menu.
Select Chart Format... from the menu. The Chart Format window is displayed.
Click the Labels tab.

Select Show measure name on value axis.

Click Apply, then OK. The name appears along the value axis.

ANl e

To remove a measure name, open the Labels tab and deselect Show measure name on value axis.

4.3.3.3 Restricting Label Display

By default, every field included in your chart has a label displayed along either axis. Measures will show up as
numeric values, often along the Y axis, and fields being measured will show up as text along the X axis. On
some charts - especially those with many included fields - these labels may overlap, crowd together, or become
difficult to read. You can alleviate this problem by "stepping," or reducing, the number of labels displayed on
your chart.

To reduce the number of labels on your chart:
1. Inthe Ad Hoc View panel, click the %~ icon to show the Canvas Options menu.
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Select Chart Format... from the menu. The Chart Format window is displayed.
Click the Axis tab.

In the Interval between X-axis labels numeric entry box, specify how often you want the axis label to
appear. For instance:

* To display every second label, enter 2.
» To display every third label, enter 3, and so on.
Repeat this process in the Interval between Y-axis labels numeric entry box.

Click Apply, then OK. The labels appear as entered.
To display every label, open the AXis tab and enter 1 in the numeric entry boxes.

4.3.3.4 Rotating Label Text

By default, labels on your chart are displayed horizontally. Multiple labels, or very long ones, can be difficult to
read. You can change the direction of these labels, on both the X and Y axes, to improve chart readability.

To rotate label text:

1.

2.
3.
4

In the Ad Hoc View panel, click the %~ icon to show the Canvas Options menu.

Select Chart Format... from the menu. The Chart Format window is displayed.

Click the Axis tab.

In the Rotation of X-axis labels specify the degree of rotation to apply to labels. For instance:
* To rotate labels clockwise 90 degrees, enter 90.

*  To rotate labels counter-clockwise 90 degrees, enter -90.

*  To rotate labels clockwise 45 degrees, enter 45, and so on.

Repeat this process in the Rotation of Y-axis labels entry box for measures along the Y axis.
Click Apply, then Close. The labels are rotated.

To return the labels to their original, horizontal position, open the AXis tab and enter 0 in the numeric
entry boxes.

4.3.3.5 Changing the Chart's Appearance Using Advanced Formatting

The Advanced tab on the Chart Format window gives you more control over the appearance of an Ad Hoc
chart by allowing you to edit certain chart properties. For example, you can specify a list of colors for the chart,
change the position of the legend, choose whether to display data values in the chart, and much more. You can
find a full list of supported commands by clicking the More Information link on the Advanced tab or
browsing to the Advanced Chart Formatting page on the Jaspersoft Community Site.

To edit the chart's properties:

1.

2
3.
4.
5

In the Ad Hoc View panel, click the %~ icon to show the Canvas Options menu.

Select Chart Format... from the menu. The Chart Format window is displayed.

Click the Advanced tab.

Click Add New Property.

In the Property field, enter the chart property you want to format and then enter the value(s) for the
property. For instance:

* To format the chart's colors, enter colors for the property and a comma-separated list of colors in
brackets for the values, such as ["red", "blue", "green", "magenta", "purple", "black", "yellow"].
*  To change the vertical alignment of the legend, enter legend.verticalAlign for the property and "top" or

"bottom" or "center" for the value.
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4.3.4

* To display data values on the chart, enter plotOptions.series.datalLabels.enabled for the property and
true for the value.
Click the More Information link to see a list of the properties you can edit.

The Ad Hoc Designer does not validate the property name or values. The chart will ignore any invalid
property you enter.

6. Click v to save the property formatting.
7. Click Apply, then Close. The chart is updated with the new formatting.

8. To remove the formatting, open the Advanced tab and click I next to the property you want to remove.

Interacting with Charts

Once you have chosen rows and columns and selected the type of chart you want, you can further explore your
data using interactive features such as brushing an area of the chart to zoom in or clicking on a legend to hide
the members of a group.

4.3.4.1 Zooming

Zooming lets you view a specific area of a chart more closely. Zooming can also be helpful when the labels at
the bottom of a chart are difficult to read, because only the labels corresponding to the selected area are
displayed.

Zoom is a viewing feature of the Ad Hoc Editor. When you save an Ad Hoc view, or create a report from an
Ad Hoc view, the zoom is automatically reset to show the whole chart.

To zoom in on an area of a chart:

*  Click and drag or brush the area you want to zoom in on. As you are dragging or brushing a pale blue area
indicates your selection. When you release the mouse button, the view zooms in on the area you selected.

To view the whole chart again:
* Click Reset zoom at the upper right of the canvas.

The following images show a bar chart before and after zooming:
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4.3.4.2 Hiding Group Members

Use the legends below the chart to hide or show group members.

* To hide a group member, click the member name in the legend below the chart. The member is removed
from the chart and the legend is grayed out.

*  To unhide a group member that has been hidden, click the grayed-out legend for the member.
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Figure 4-8 Hiding a Group Member

Hidden members are a view feature of the Ad Hoc Editor. When you save an Ad Hoc view, or create a
report from an Ad Hoc view, the chart is automatically reset to show all members.

Working with Standard Crosstabs

3 This section describes crosstabs based on Topics and Domains. For information about crosstabs based
on OLAP connections, refer to “Working with OLAP Connection-based Crosstabs” on page 115 and
“Working with Topics” on page 151.

Crosstabs have different data, layout, and format options than tables or charts.

If you selected Crosstab when you created a view, as described in “Ad Hoc View Types” on page 86, the
following sections explain tasks specific to your crosstab development.

Using Fields in Crosstabs

Fields can be added to crosstabs as row groups or column groups. Measures can be added to crosstab rows or
columns as well, but all measures must be included as either a row or a column — that is, you can add one or
more measures as columns, or add one or more measures as rows, but you cannot have one measure as a column
and another as a row in the same crosstab.

4.4.1.1 Crosstab Rows and Columns

When creating a crosstab view, keep in mind that row and column groups are arranged in hierarchies. Drag the
group headings to rearrange the hierarchy; you can also right-click a heading and select a Move option from the
context menu or press the cursor keys. Rearranging the groups may change the preview data in the editor.

To add a field or measure to a crosstab group:

1. In the Data Source Selection panel, click to select the field(s) you want to add to the crosstab as a group.
Use Ctrl-click to select multiple items.

2. Drag your selection into the Columns or Rows box in the Layout Band.
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4.4.1.2 Crosstab Measures

Measure labels are displayed in the crosstab based on their status as a row or column:

*  Measures included as rows appear in the crosstab below the Measures heading.
*  Measures included as columns appear in the crosstab to the right of the Measures heading.

You can right-click a measure in the crosstab to open a context menu that provides these options:

¢ Change Summary Function
* Change Data Format

* Remove From Crosstab

e Create Filter

*  Move Up or Move Down

Measures are arranged in cells. You can add any number of measures. All the measures appear together in every
cell. To rearrange the measures, drag them in the measure label area.

4.4.1.3 Pivoting

You can pivot a crosstab in two ways:

*  Pivot the entire crosstab by clicking IT’ . The row and column groups switch places. For more
information, see “Creating a View from a Domain” on page 146.

* Pivot a single group:
* To pivot a single row group, right-click it and select Switch To Column Group.
* To pivot a single column group, right-click it and select Switch To Row Group.

z, Pivoting removes any custom sorting applied to headings in your crosstab. It does not affect column or
row sorts.

4.4.1.4 Slicing

The slice feature lets you keep or exclude group members in a crosstab. To slice, right-click a group member and
select:

+  Keep Only to remove all groups except the selected one from the crosstab.

* Exclude to remove this group from the crosstab.

Use Ctrl-click and Shift-click to select multiple groups to keep or exclude.

z; You can select multiple row groups or multiple column groups; you can't slice by both row groups and
column groups at once. Compare slice to drill-through, drill to details, and filtering.

For more information about filtering, see “Using Filters and Input Controls” on page 139.

4.4.1.5 Summarizing

All row and column groups are summarized automatically:

e To tum off a group summary, right-click any heading in the group and select Delete Row Summary or
Delete Column Summary from the context menu. To reapply the summary, right-click the heading and
select Add Row Summary or Add Column Summary.

z; The Delete Summary option is available only for the outermost group on either axis (thatis, either the
outermost row group or the outermost column group)
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*  To select the summary function and data format for a measure, right-click the measure label and select from
the context menu. Note that you can’t change the summary function on custom fields that calculate percents
(Percent of Total, Percent of Column Group Parent, and Percent of Row Group Parent).

*  The summary functions for numeric fields are Sum, Average, Maximum, Minimum, Distinct Count, and
Count All. Distinct Count is the number of different items in the row or column; Count All is the total
number of items. For instance, if there are 3 widgets of type A and 3 widgets of type B, Distinct Count is 2
and Count All is 6.

4.4.1.6 Collapsing and Expanding Members

By default, the editor displays each row and column group of a crosstab in a collapsed state. This means you
can see the totals for the group, but not the measures for its individual members. To see measures for a group’s
members, right-click the group label and select Expand Members.

When a group’s members are expanded, select Collapse Members from the same menu to hide the measures.
Collapsing an outer group also collapses its inner groups. The Expand Members and Collapse Members
options are available only for outermost groups, or for inner groups nested in an expanded outer group.

When you collapse a group, its summary is automatically displayed; this prevents invalid crosstab layouts in
which there is nothing to display for some totals if the summary has been deleted previously.

4.4.1.7 Merging and Unmerging Crosstab Cells

By default, the editor merges cells containing the same data into a larger, single cell to make the crosstab data
easier to read. The following image shows a crosstab with merged cells.

To display all of the individual cells in the crosstab instead of merged cells, hover over . and select
Unmerge crosstab cells. The following image shows a crosstab with unmerged cells.

s
To merge the crosstab cells, hover over and select Merge crosstab cells.

4.4.1.8 Sorting

By default, the rows and columns of crosstabs are sorted in alphabetical order of the group names.

To sort your crosstab:
* Right-click the heading you want to use for sorting and select one of these options:
* Sort Ascending
+ Sort Descending
+ Don't Sort
The crosstab is updated to reflect your sorting option. A blue dot appears in the context menu next to the
currently applied sort option.

When the crosstab includes more than one row group or more than one column group, the inner groups are also
sorted according to your selection. Only one measure can be used for sorting at any one time; changing the sort
order for another measure resets all others to the default.

To filter top or bottom N values:

You can filter the numeric data shown in a crosstab to show only the rows with the top or bottom N values,
where N is a number that you specify. For example, you can filter a crosstab to display only the top 10 values
in a column.

1. Right-click the heading you want to use for filtering and select one of these options:
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* Filter Top N Values

* Filter Bottom N Values

* Don't Filter Values

Enter the number of values you want to show in the crosstab.

Select whether to show an aggregate of the unranked values in the crosstab.
Select whether to apply the filter across all row groups.
Click OK.

The crosstab is updated to reflect your filter option. The Y= icon appears in the heading when filtering a

A

column for the top N values, while the T icon appears when filtering for the bottom N values. A blue dot
appears in the context menu next to the currently applied filter option. Only one measure can be used for
filtering at any one time; changing the filtering or sort order for another measure resets the filtered column.

4.4.1.9 Resizing and Layout

Many of the layout and formatting options that are set manually in tables are set automatically in crosstabs. In
particular, row and column sizes are fixed and no spacer is available.

4.4.1.10 Drilling Through Data

4.5

4.5.1

Drill-through functionality is available for crosstab data. A drill-through table displays the supporting details for
the selected roll-up value.

To view the drill-through table for a value in your crosstab:
*  Click hyperlinked data to display additional columns from that specific fact data.

By default, the drill-through table opens in its own window or tab, depending on your browser settings.

Working with OLAP Connection-based Crosstabs

An OLAP connection is a definition for retrieving OLAP data for use in Ad Hoc views and reports. An OLAP
connection is either a direct Java connection (Mondrian connection) or an XML-based API connection (XML/A
connection). You must create OLAP client connections in order to use this functionality, which may be
restricted by your license. For more information on creating OLAP client connections, as well as other
administrative tasks regarding OLAP, refer to the Jaspersoft OLAP User Guide.

The Ad Hoc Editor displays a more focused tool bar when your Ad Hoc view is based on an OLAP connection.
It contains a subset of the options available in the standard tool bar, including Display Mode, Redo, Undo All,
Switch Group, Display Options, and View MDX Query. For a description of these options, see Table 4-1.

Dimensions and Measures

When you create a view based on an OLAP connection, the cube metadata defined in the connection’s OLAP
schema is automatically applied to your data: the dimensions and measures in the cube are shown in the Data
Source Selection panel.

Dimensions and measures describe your data in terms of these organizing principles and facts:

+ Dimension: A categorization of the data in a cube. For example, a cube that stores data about sales figures
might include dimensions such as time, product, region, and customer’s industry. A dimension is a
hierarchical series of relationships in which each level has a parent and may also have children. Note that a
level is a particular location within the dimension, whereas a member is a specific data element at a
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4.5.2

particular level. For example, if the dimension is Geography, then one of its levels might be Country; at the
Country level, USA might be a member.
Some dimensions include a special level at the top of the hierarchy that includes every level in the
dimension. This All member is used to display the summarized data across the dimension. The All member
of dimensions is a common feature in many OLAP solutions.

* Measure: A field that displays the facts that constitute the quantitative data in a cube. For example, a cube
that stores data about sales figures might include measures such as unit sales, store sales revenue, and store
sales cost.

The items in the Dimensions section of the Data Source Selection panel may appear in a multi-level tree
structure. You can add the entire dimension tree, or any sub-trees, to your crosstab by dragging the top-level
name into the Layout Band. Individual items can be added to the crosstab in the same manner.

Items in the Measures section are organized into a single-level list. Any calculated measures are indicated by a
calculation icon .

When working with OLAP connections, the Layout Band at the top of the Ad Hoc View panel allows you to
drag and drop dimensions and measures into the crosstab. As you add columns and rows, the crosstab
automatically builds on the panel. In the Columns and Rows fields, each item in your crosstab is represented
as a token; drag tokens left and right to change their position on an axis or drag them between the fields to
pivot them.

The cube metadata applied to your view provides structure to your crosstab: you can add a dimension with any
number of levels, but it must follow the hierarchy defined in the cube. For example, if a dimension’s levels are
Country, State, and City, you can place any one of them in the crosstab, but if you add two or more, their order
(defined in the OLAP schema) is enforced. For example:

Possible Impossible
Country, State, City State, Country, City
Country, City City, Country
State, City City, State

Country, State State, Country

In addition, you can’t mix members from different dimensions. For example, consider a crosstab that includes
both a Geography dimension (Country, State, and City) and a Time dimension (Y ear, Quarter, and Month): you
can’t insert the Year level between the Country and State levels. The levels of each dimension are always kept
together.

All measures in the crosstab must be either rows or columns. You can’t have measures on both axes at the same
time. To move measures between dimensions, right-click and select Switch To Column Group or Switch To
Row Group. All the measures move to the other axis.

Drilling Through Data

Drill-through functionality is available for crosstab data. A drill-through table displays the supporting details for
the selected roll-up value.
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4.5.3

4.5.4

4.5.5

To view the drill-through table for a value in your crosstab:
1. Click hyperlinked data to display additional columns related to that information.

2. Use the page controls to navigate the table.

The drill-through table opens in its own window or tab, depending on your browser settings.

Sorting

Like standard crosstabs, the rows and columns of an OLAP crosstab are sorted in alphabetical order of the group
names.

To change the sorting of your OLAP crosstab:
* Right-click the heading you want to use for sorting and select one of these options:
* Sort Ascending
* Sort Descending
« Don't Sort
The crosstab is updated to reflect your sorting option. A blue dot appears in the context menu next to the
currently applied sort option.

When the crosstab includes more than one row group or more than one column group, the inner groups are also
sorted according to your selection. Only one measure can be used for sorting at any one time; changing the sort
order for another measure resets all others to the default.

Viewing the MDX Query

You may want to view the MDX query created for the OLAP connection used with your crosstab, to verify
what data users are hitting. If this option is enabled, you can do this in the Ad Hoc Editor with the View
Query button.

The query is read-only, but can be copied to a document for review.

To view the MDX query:

* In the tool bar, click =@  The View Query window opens, displaying the query.

Working with Microsoft SSAS

The Ad Hoc Editor allows you to view data from Microsoft SQL Server Analytical Services (SSAS) to populate
views and reports with multi-dimensional OLAP data. XML/A connections that point to your SSAS data are
listed with the other OLAP connections when you create an Ad Hoc view, as in the following chart example.
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Figure 4-9 Search Results Listing

For details, refer to the Jaspersoft OLAP User Guide.

4.6 Calculated Fields and Measures

You can create new fields or measures in an Ad Hoc view by applying formulas to a view’s existing fields and
measures. For example, consider a view that includes both a Cost and a Revenue field. You could calculate the
profit for each record by creating a custom field that subtracts the Cost field from the Revenue field. For
example, you can divide the Profit custom field in the previous example by the Revenue field to express each
record’s margin as a percent.
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If you have installed the samples, the Ad Hoc view 10. Calculated Fields and Measures includes examples

of calculated fields (shown by the icon f’"—") or calculated measures (shown by the icon frd ). You can explore

their formulas by right-clicking the field or measure name and selecting Edit. You can also create tables, charts,
or crosstabs to see how these calculations work in views.

4.6.1 Overview of the Calculated Fields Dialog Box

The Calculated Field or Calculated Measures dialog box allows you to create a calculated field or measure
and set its summary function. This section describes the functionality available in this dialog box.

To open the calculated fields dialog box for Ad Hoc views:

1.
2.

Create or open an Ad Hoc view.

Open the calculated fields dialog using one of these methods:

»  Click @~ at the top right of either the Fields section or the Measures section of the Data Source
Selection panel and select Create Calculated Field... from the context menu.

*  Right-click on an existing calculated field (shown by the icon Jrj"—I]) or calculated measure (shown by

the icon f;-f) and select Edit.
The dialog displays a text field for the name and two tabs, Formula Builder and Summary.

e following are reserved words and cannot be used as field names: AND, And, and, IN, In, in, NOT, Not,
Fot, OR, Or, or. Names containing these strings, such as "Not Available", can be used.

4.6.1.1 The Formula Builder Tab

The Formula Builder tab is where you create the formula for your calculated field or measure. This tab includes
the following:

Formula entry box — Shows the current formula for calculating your field or measure. You can edit the

formula by typing directly in the panel. You can also add Fields, Measures, and Functions by double-

clicking them. Click the buttons below the Formula field to add operators. Formulas must use the following

syntax:

a. Labels for fields and measures must be in double quotes ("): "Customer ID", "Date ordered".

b. Text must be in single quotes (): '--'.

c. Levels must be in single quotes ('): 'ColumnGroup', 'Total'. See Levels in Aggregate Functions for more
information about levels.

For more information on syntax, see Calculated Field Syntax.

Operator buttons — Click these buttons to insert the operator in the Formula entry box. For more

information on operators, see Operators in Ad Hoc Views

Fields and Measures — Lists all the fields and measures currently in your Ad Hoc view, including any

calculated fields or measures you have already created.

Functions — Lists all the available functions you can use in your formula. For more information, see

Calculated Field Reference.

Function Description panel — Gives a brief description of the function selected in the Functions list, if any.

The sample inputs are intended to be as descriptive as possible. See Calculated Field Reference for the

precise syntax each function requires.

Show arguments in formula checkbox — When this checkbox is selected, double-clicking a function name

in the Functions list adds the full description to the Formula entry box; when the checkbox is not selected,
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double-clicking a function name adds only the function. For example, double-clicking Round adds Round
("NumberFieldName", Integer) when the checkbox is selected, and adds Round () when the checkbox
is not selected. If you select this checkbox, you can double-click on a string, such as NumberFieldName,
and then replace it by double-clicking a name in the Fields and Measures list.

Validate button — Checks the formula for syntax errors, such as missing parentheses or quotes. Your
calculated field or measure must be valid before you can create it. Syntax validation does not guarantee that
your formula will give the results you want.

4.6.1.2 The Summary Tab

Summaries show a result applied to all data values. For example, for a numeric fields such as Cost, the summary
value might be the sum of all the costs; for a text field such as Customer Name, the summary value might be the
count of all customers. The Summary tab lets you set the default summary function for your calculated field or
measure.

3

Calculation list — Displays allowed summary functions for your calculated field or measure. The available
options depend on the data type of the calculation. See Summary Calculations for more information.
Depending on your selection, you may see additional options:

*  Custom selection — Displays the same options available in the Formula Builder tab, including the
Formula entry box, operator buttons, Fields and Measures list, Functions list, and Validate button. You
use these options to build a formula for your custom summary. However, for summaries, you are limited
to aggregate functions, that is, functions that operate on all the values in your field. For example, Sum
and Mode are valid summary functions, because they use all available field values to get a result. Round
is not a valid summary function, because it operates on a single value at a time. See Summary
Calculations for more information.

*  Weighted Average — Displays a Weighted On drop-down list, which allows you to choose another
field or measure to use as the weight for the average.

4.6.2 Creating a Calculated Field

To create a calculated field:

1.

b

First, create the Ad Hoc view to use. To do this, select Create > Ad Hoc View from the menu. The Select
Data wizard appears.

Click 5 and navigate to Domains.
Select Supermart Domain. Click Choose Data. The Data Chooser window appears.
In the Data Chooser window, double-click Sales to select it and click OK. A new Ad Hoc view opens.

In the Ad Hoc view, click B~ at the top right of the Fields section and select Create Calculated Field...
from the context menu. The New Calculated Field dialog box appears, displaying the Formula Builder.
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New Calculated Field

Field Name:

Volume Tier

Formula Builder

Formula:

Summary Calculation

IF("Unit Sales 2013" IN (0:100), 'Low', 'High')

Cancel

Validate @ validation successf

- |* fl|%) |t ) AND OR NOT IN =|||=||=> < | |»=| €=
Fields and Measures: Functions: Function Description:
|| State “ fe| Elapsedyears IF
] State/Pravince U EndsWith Returns second argument if first argument is true;
=il Store Cost 2013 IF returns optional third argument if first argument is
false.
|| Store Name | 1shull =z
=i Store Number (1-24) ﬂ Length IF({"BocleanFieldName", TrueCalc,
B FzlseCalc)
=i} Store Sales 2013 £ Max
|| Store Street Address \fe| median
|| Store Type | mid
=} Unit Sales 2013 - | Min #| Show arguments in formula

Figure 410 Formula Builder Tab in New Calculated Measure Dialog Box

6. Enter Volume Tier for the Field Name.

Creating the formula:

This section shows how to create a simple text formula that says Low when the Unit Sales amount is under 100

and High otherwise.

Formulas must use the following syntax:

a. Labels for fields and measures must be in double quotes ("): "Customer ID", "Date ordered".
b. Text must be in single quotes ('): '--'.

c. Levels must be in single quotes ('): 'ColumnGroup', 'Total'.

Make sure Show arguments in formula is selected.

Now create the formula. Double-click IF() in the Functions list.

Because Show arguments in formula is selected, IF ("BooleanFieldName", TrueCalc, FalseCalc)
is entered in the Formula Builder.

Double-click BooleanFieldName to select it, then double-click Unit Sales 2013 in the Fields and

The Formula Builder displays IF ("Unit Sales 2013", TrueCalc, FalseCalc).
Edit the expression in the Formula Builder to read as follows: IF ("Unit Sales 2013™ IN (0:100),

9.

Measures list.
10.

"Low', 'High'").
11.

Click Validate to verify that the formula does not have any syntax errors.
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4.6.3

Creating a summary calculation:

The Ad Hoc Editor creates a default summary calculation based on the type of formula you have entered. This
section shows how to select a different summary function.

12. Click the Summary Calculation tab.

New Calculated Field

Field Name:
Welume Tier
Formula Builder Summary Calculation
Calculation:
Mode r
Create Field Cancel

Figure 411 Summary Tab in New Calculated Measure Dialog Box

13.
14.

Select Mode from the Calculation menu.
Click Create Field.
The calculated field appears in bold text at the bottom of the list of available fields. A special icon

indicates it is a calculated field -"r""—l].

If you have installed the samples, the Ad Hoc view 10. Calculated Fields and Measures includes examples

of calculated fields and measures (indicated by Jd ). You can explore their formulas by right-clicking the field
or measure name and selecting Edit. You can also create tables, charts, or crosstabs to see how these
calculations work in views.

Planning and Testing Calculated Fields and Measures

When you are creating calculated fields and measures, you may need to follow an iterative process: first create
your new fields and measures, then view the results, and finally adjust as needed. The following practices can
help:

Reduce the size of your data set — To speed field creation and testing, reduce the size of your working data

set in the following ways:

*  Select Sample Data from the drop-down menu in the Ad Hoc tool bar.

*  Create one or more filters. This is especially useful for tables, which display all data by default.

*  Limit the number of fields and measures you add to your test reports to restrict the number of summary
levels to one or two.

Create one or more formulas, as described in Creating a Calculated Field.

After you have created your fields and measures, add them to a table or crosstab in your view and verify

that they behave as you expect. You may need to edit your fields to get the desired behavior. See Creating

a Calculated Field for more information.
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4.6.4

In addition, keep the following in mind when creating calculated fields:

*  When you create a calculated field, it appears at the bottom of the list.

*  Calculated fields that use aggregate functions cannot be added to groups and should not be used as filters.

* By default, the Ad Hoc Editor supports only two decimal places. If the calculated fields return data that are
significant to the third decimal place, you can add new masking options by editing configuration files. For
more information, refer to the JasperReports Server Administrator Guide.

*  You can’t delete a calculated field that is in use; these fields have their name in italics.
» Ifthe calculated field is used in the Ad Hoc view panel, remove the calculated field from the Ad Hoc

View panel and then delete it from the Data Source Selection panel.

» Ifthe calculated field is the basis of another field, you can’t delete it until you delete the one that
builds on it.

Calculated Field Reference

This section lists all functions that can be used to create calculated fields and measures in Ad Hoc views. For
details of the supported syntax, see Calculated Field Syntax.

These functions are available for calculated fields and measures in Ad Hoc views only. See Operators
and Functions for supported operators and functions in Domains.

The examples in this section indicate correct syntax, but are not necessarily associated with an Ad Hoc view. If
you have installed the Jaspersoft samples, the Ad Hoc view 10. Calculated Fields and Measures includes
examples of calculated fields (shown by the icon f)) or calculated measures (shown by the icon gif'). You can

explore their formulas by right-clicking on the field or measure name and selecting Edit. You can also create
tables, charts, or crosstabs to see how these calculations work in views.

Absolute (NumericExpression)

Returns the absolute value of a number or field, that is, the non-negative value of the number.
Example:

Absolute ("Transaction Amount") — Shows the magnitude of each transaction, regardless of whether the
transaction is positive or negative.

"Commission Rate" * Absolute ("Transaction Amount") — Computes a positive commission on all
transactions, regardless of whether the transaction is positive or negative.

Attribute('StringExpression1’, ['StringExpression2' ])

Given the name of an attribute as the first argument and an optional category as the second argument, returns
the attribute's current value as a String. If a category is specified (USER, TENANT, or SERVER), returns a
categorical attribute; returns a hierarchical attribute otherwise. This value can be cast to a different datatype
using one of the casting functions available in Ad Hoc: Boolean (), Date (), Decimal (), Integer (), Time (),
or Timestamp (). It is your responsibility to ensure the attribute's format and values work correctly with your
Ad Hoc view. See the JasperReports Server Administrator Guide for more information about creating and using
attributes.

TIBCO Software Inc. 123



JasperReports Server User Guide

Average(NumericExpression[,'Level])

Returns the average value of a measure or numeric field, based on an optional level. Null values are not
included. See Levels in Aggregate Functions for more information.

Example:

Average ("Salary", 'RowGroup')

Boolean ('StringExpression’)

Casting function that takes a String expression and converts it to a Boolean data type. The String can be any
expression that returns a supported string, including a field value or an attribute retrieved with the Attribute
() function. The Boolean () function requires one of the following Strings: true, false, True, False, TRUE, or
FALSE. Other Strings will return an error.

Example:

Boolean ('true')

Case(Expression, ValueExpression1, ReturnExpression1, ValueExpression2, ReturnExpression2[,...,
ValueExpressionN, ReturnExpressionN][,DefaultReturnExpression])

Takes 2N+1 or 2N+2 arguments: an expression followed by one or more value expression/return expression
pairs, with an optional final return expression. Compares the expression in the first argument to each value
expression in order of appearance. Returns the value of the expression immediately following the first value
expression that matches. If no expression matches, returns the final DefaultReturnExpression if present, null
otherwise.

The types of all the return expressions must be compatible. For example, you can't mix numeric and text return
value types.

Example:

Case ("Shipped by", 1, 'FedkEx', 2, 'UPS', 3, 'USPS', 'Unknown')

CaseRange (NumericExpressionlnput, NumericExpression1, ReturnExpression1, NumericExpression2,
ReturnExpression2[,..., NumericExpressionN, ReturnExpressionN][,DefaultReturnExpression])

Takes 2N+1 or 2N+2 arguments: an expression followed by one or more numeric expression/return expression
pairs, with an optional final return expression. Finds the first numeric expression that is greater than the input
expression and returns the value of the corresponding return expression. If no expression is greater, returns the
final DefaultReturnExpression if present, null otherwise.

The types of all the return expressions must be compatible. For example, you can't mix numeric and text return
value types.

Examples:
Case ("Temperature", 60, 'too cold', 80, 'just right', 'too hot')
CaseRange (CountAll ("Shipping charge") % CountAll ("Shipping charge", 'Total'), 2.0, 'Less
than 2%', 5.0, '2% - 5%', 'More than 5%')
CaseWhen(BooleanExpression1, ReturnExpression1, BooleanExpression2, ReturnExpression2|,...,
BooleanExpressionN, ReturnExpressionN][, DefaultReturnExpression])

Takes 2N or 2N+1 arguments: one or more pairs of Boolean expressions followed by return expressions, with an
optional final return expression. Returns the expression immediately following the first true Boolean expression.
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If no expression is true, returns the final DefaultReturnExpression if present, null otherwise. This is the most
flexible construct.

The types of all the return expressions must be compatible. For example, you can't mix numeric and text return
value types.

Example:

CaseWhen ("Shipped by" == 1, 'FedEx', "Shipped by" == 2, 'UPS', "Shipped by"== 3, 'USPS',

'Unknown')

Case ("Temperature" <= 60, 'too cold', "Temperature" > 80, 'too hot', 'just right')

Concatenate(TextExpression1[ ,TextExpression2,...,TextExpressionN])

Combines multiple text strings and/or fields into a single text field. Text strings are enclosed in single quotes;
labels for fields or measures in Ad Hoc are enclosed in straight quotes.

Examples:
Concatenate ("Last Name", ' , ', "First Name")
Concatenate ("Product Category", ' -- ', "Product Name")

Contains(TextExpression1 ,TextExpression2])
Boolean that returns true if the first string contains the second, false otherwise.
Examples:

Contains ("Product Name", 'Soda')

CountAll(Expression[,'Level)]

Returns the count of non-null items in a field or measure; note that Countall always returns a non-negative
integer. Level can be one of the following: Current (default), ColumnGroup, ColumnTotal, RowGroup,
RowTotal, Total. See Levels in Aggregate Functions for more information.

Example:
CountAll ("Transaction Amount", 'RowGroup') — Counts the total number of non-null transactions in the
specified group.

CountDistinct(Expression[,'Level])

Returns the distinct count of non-nu